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1 Getting Started
pli-
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ary.
Lahey/Fujitsu Fortran 95 (LF95) is a set of software tools for developing 32-bit Fortran ap
cations. LF95 is a complete implementation of the Fortran 95 standard. The toolset incl
a compiler, editor, linker, debugger, profiler, coverage tool, librarian, make utility, video
graphics and user interface library.

LF95 includes three manuals: theUser’s Guide(this book), which describes how to use the
tools; theLanguage Reference, which describes the Fortran 95 language; and theWinteracter
Starter Kit Manual, which describes the Windows video graphics and user interface libr

System Requirements
• An 80486DX, Pentium series or compatible processor
• 24 MB of RAM (32 MB or more recommended)
• 62 MB of available hard disk space for complete installation; 55 MB for typical

installation
• Windows 95, Windows 98, or Windows NT 4.0, or Windows 2000.

Manual Organization
This book is organized into eight chapters and two appendices.

• Chapter 1,Getting Started, identifies system requirements, describes the installation
process, and takes you through the steps of building of your first program.

• Chapter 2,Developing with LF95, describes the development process and the driver
program that controls compilation, linking, the generation of executable programs,
libraries, and DLLs.

• Chapter 3,Editing and Debugging with ED, describes program creation and debug-
ging using the Windows-based programming environment.
Lahey/Fujitsu Fortran 95 User’s Guide 1
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• Chapter 4,Command-Line Debugging with FDB, describes the command-line
debugger.

• Chapter 5,Windows Debugging with WinFDB, describes how to automate program.

• Chapter 6,LM Librarian, describes command-line operation of the librarian.

• Chapter 7,Automake, describes how to automate program creation.

• Chapter 8,The Sampler Tool, describes how to profile your code to discover oppor-
tunities for execution speed optimization.

• Chapter 9,The Coverage Tool, describes the coverage analysis tool which can be
used to determine if all portions of your code are being executed.

• Chapter 10,Utility Programs, describes how to use the additional utility programs.

• Appendix 11,Programming Hintsoffers suggestions about programming in Fortran
on the PC with LF95.

• Appendix 12,Runtime Optionsdescribes options that can be added to your execut-
able’s command line to change program behavior.

• Appendix 13,Lahey Technical Supportdescribes the services available from Lahey
and what to do if you have trouble.

Notational Conventions
The following conventions are used throughout this manual:

Code andkeystrokes are indicated by courier font.

In syntax descriptions,[brackets]enclose optional items.

An ellipsis, '...', following an item indicates that more items of the same form may appe

Italics indicate text to be replaced by the programmer.

Non-italic characters in syntax descriptions are to be entered exactly as they appear.

Product Registration
To all registered LF95 users, Lahey provides free, unlimited technical support via teleph
(PRO version only), fax, postal mail, and e-mail. Procedures for using Lahey Support S
vices are documented in Appendix 13,Lahey Technical Support.

To ensure that you receive technical support, product updates, newsletters, and new r
announcements, please register during installation or at our website: http://www.lahey.c
If you move or transfer a Lahey product’s ownership, please let us know.
2 Lahey/Fujitsu Fortran 95 User’s Guide
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Installing Lahey/Fujitsu Fortran 95
1. Insert the LF95 CD into your CD drive to display the Lahey/Fujitsu Fortran 95 Setup

Menu.

2. If the Setup Menu does not display, rund:\install.exe whered is the drive letter
of your CD drive.

3. For Windows NT and Windows 2000 users, run the installation while logged into the
account which you will be using when running LF95. Administrator rights are
required for installation.

4. Select ‘Install Lahey/Fujitsu Fortran 95’ from the Setup Menu. You’ll be prompted
to enter or verify your LF95 serial number. The serial number is required to install
LF95 and to receive technical support. You'll also be given the choice to run Online
Update as a post-installation option. This will update your product to the most recent
version of LF95 from Lahey's web site.

5. Reboot your system(or log out and log in if using Windows NT) -- this insures that
your system environment is properly configured. You are now ready to build your
first program.

Network Installation
Network Administrator: The network administrator role is to install the files on a networ
server drive for use by users on the client systems. Running the installation with the co
mand line arguments below will install the product files without creating icons (except t
Internet folder to access Online Update) and without updating the system for use of the
installed product components. It is required that you have purchased a site license from
Lahey Computer Systems, Inc. or that you run monitoring software that limits the numbe
concurrent users of each tool in the distribution to the number of licenses purchased.

1. Enter this in the Start|Run option (do not run from the autoplay Setup Menu):

<d> :\Install32 netserver[ main:<n-m> ed4w:<n-e> ]

with these substitutions (the network pathname is the drive and directory specification)

<d> = the CD drive containing the Lahey/Fujitsu Fortran 95 CD

<n-m> = the network pathname for the compiler installation

<n-e> = the network pathname for the Lahey ED Developer installation

Note: the command line arguments surrounded by brackets are optional.
Lahey/Fujitsu Fortran 95 User’s Guide 3
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2. You will be prompted to accept the License Agreement, enter your registration inform
tion, enter/verify your installation directories, and to select which components you wish
install.

3. It is recommended that you make a batch procedure to distribute to your client users
taining the command line shown below for the Network Client. Copy the file
INSTALL32.EXE to a network-accessible drive for the clients to run the installation.

4. If the online documentation component is installed, then it is recommended that the A
Acrobat Reader install be made available for client users. This can be accomplished by
ing the "ARxxxENG.EXE" installation program (wherexxx is the version number) from the
product CD to a network drive for the network users to run.

Network Client: Running the installation with the command line arguments below will ins
only those product files needed to be resident on the local system. The system files wil
updated as necessary and icons will be updated as appropriate.

1. You must have the network drive mapped as a local drive letter (e.g., starting with
"N:"); do not specify a UNC style name (e.g., starting with "\\"). This requirement is
for proper startup of Lahey ED Developer.

2. Enter this in Start|Run (do not run from the autoplay Setup Menu):

<n-i> \install32 netclient[ main:<n-m> ed4w:<n-e> local:<d-l> ]

with these substitutions (the network pathname is the drive and directory specification)

<n-i> = the network pathname where INSTALL32.EXE is located

<n-m> = the network pathname where the network admin installed the compiler

<n-e> = the network pathname where the network admin installed Lahey ED

<d-l> = the local pathname if the default of C:\Lahey is not desired.

Note: the command line arguments surrounded by brackets are optional.

3. If "main:" is not on the command line, the client user will be prompted to accept the
License Agreement, enter the network location of the product, select desired shortcuts
to choose whether or not to have the installation program update the system environm
variables.

If "main:" is contained in the command line, the client user will not be prompted for any
information, and the defaults will be used.
4 Lahey/Fujitsu Fortran 95 User’s Guide
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Maintenance Updates
Mainenance updates are made available for free from Lahey's web site. They comprise
fixes or enhancements or both for this version of LF95.The update program applies "patc
to your files to bring them up-to-date. The maintenance update version shows as a letter
the version of your compiler. This is displayed in the first line of output when you run th
compiler.

To check Lahey's web site for the latest maintenance update for this version, click on On
Update in the Lahey/Fujitsu Fortran 95 Internet folder in your Programs menu, and a prog
will step you through it. Online Update will first perform a quick check and tell you wheth
you are up-to-date or if an update is available. If you choose to install the update, the n
sary file patches will be downloaded and applied. You will need to be connected to the
Internet to perform the check and to download the files.

Another way to get the latest maintenance update for this version is by going to this web p

http://www.lahey.com/patchfix.htm

There you will find update programs you can download, as well as release notes and bu
descriptions. Once you have downloaded an update program, you will no longer need
Internet connection. This method is preferred over Online Update by those who need t
update LF95 on systems that are not connected to the Internet, or who want the ability
revert to a previous maintenance version.

Building Your First LF95 Program
LF95 is commonly referred to as a “compiler,” but it is comprised of a linker, a librarian, a
several other components. For this reason it is more accurately referred to as the “LF9
driver.” Building and running a Fortran program with LF95 involves three basic steps:

1. Creating a source file using the Lahey ED development environment or a suitable
non-formatting text editor.

2. Generating an executable program using LF95. The LF95 driver automaticallycom-
pilesthe source file(s) andlinks the resulting object file(s) with the runtime library
and other libraries you specify.

3. Running the program.

The following paragraphs take you through steps two and three using theDEMO.F90source
file included with LF95. For the sake of illustration, we will use the command line interfa
to invoke LF95, even though it is a windows application.
Lahey/Fujitsu Fortran 95 User’s Guide 5
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Generating the Executable Program
Compiling a source file into an object file and linking that object file with routines from th
runtime library is accomplished using theLF95.EXE driver program.

Open a system command prompt by selecting Start|Programs|Lahey-Fujitsu Fortran 9
v5.6|Command Prompt. From the command prompt, build the demo program by chan
to the directory whereDEMO.F90 in LF95’s EXAMPLESdirectory by default, and entering

LF95 demo

This causes the compiler to read the source fileDEMO.F90(the extension.F90 is assumed by
default) and compile it into the object fileDEMO.OBJ. OnceDEMO.OBJis created,LF95

invokes the linker to combine necessary routines from the runtime library and produce
executable program,DEMO.EXE.

Running the Program
To run the program, type its name at the command prompt:

demo

and pressEnter . TheDEMOprogram begins and a screen similar to the following screen
displays:

You've successfully built and run the Lahey demonstration program.
6 Lahey/Fujitsu Fortran 95 User’s Guide



Building Your First WiSK Program

ent
hics,
ws

from
Building Your First W iSK Program
LF95 comes bundled with a graphics library called WiSK (the WinteracterStarter Kit) which
is derived from the full Winteracterlibrary created by Interactive Software Services, Ltd.
Winteracteris a Win32 and Fortran 90 dedicated user-interface and graphics developm
tool that allows Fortran programmers to incorporate dialogs, menus, presentation grap
and other windows features into their applications. Building and running an LF95 Windo
program with WiSK is accomplished as follows:

1. Create a user interface using the DialogEd and MenuEd design tools (fully docu-
mented in theWinteracterStarter Kit Manual). These tools will generate a Windows
resource (.rc ) file.

2. Create a Fortran source file using the Lahey ED for Windows editor or any other
ASCII text editor. Parameters defined in the resource file and used in the Fortran
source must be declared in the Fortran source as well (see theWinteracterStarter Kit
Manual for a detailed explanation).

3. Generate an executable program using the LF95 driver. Specify the-wisk switch
and include your Fortran source(s) and resource file on the command line.

4. Run the program.

The following paragraphs take you through steps three and four using theWISKDEMOexam-
ple included with LF95.

Generating the Executable Program
To create the executable program, first locate the fileWISKDEMO.F90in theEXAMPLES

directory, then enter

LF95 wiskdemo.F90 resource.rc -wisk

WISKDEMO.OBJandRESOURCE.RESare created.LF95.EXE then automatically links in the
appropriate libraries to produce a 32-bit Windows executable program,WISKDEMO.EXE.

Now that you have mastered the command line, you are ready to try building programs
within the Lahey ED development environment. We recommend that you first read”Editing
and Debugging with ED”on page 51.

Run the Program
To run the program, enter:

wiskdemo
Lahey/Fujitsu Fortran 95 User’s Guide 7
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Alternately, click ED's OS Program: Run button. The program begins and a window sim
to the following displays:

You’ve successfully created the WiSK demo program for Windows.

What’s Next?
For a more complete description of the development process and instructions for using
Lahey/Fujitsu Fortran 95, please turn to Chapter 2,Developing with LF95.

Before continuing, however, please read the filesreadme.txt anderrata.txt . These
contain important last-minute information and changes to the documentation.

Other Sources of Information
Files

README.TXT last-minute information
README_API.TXT Windows API programming information
README_C.TXT C-interface documentation
README_ASSEMBLY.TXT assembly-interface documentation
README_WISK.TXT last-minute WiSK information
8 Lahey/Fujitsu Fortran 95 User’s Guide



Other Sources of Information
README_COMPATIBLE.TXT compatible products directory
README_F90GL.TXT F90GL (Fortran bindings to OpenGL) information
README_F90SQL.TXT f90SQL-Lite information
README_SERVICE_ROUTINES.TXT POSIX and other service routines
FILELIST.TXT description of all files distributed with LF95
ERRATA.TXT changes that were made after the manuals went to press
LINKERR.TXT linker error messages

Manuals (supplied both on-line and in hard copy)
Lahey/Fujitsu Fortran 95 Language Reference
Winteracter Starter Kit

Manuals (supplied on-line only)
C Compiler User’s Guide(if selected at installation time)
SSL2 User’s Guide
SSL2 Extended Capabilities User’s Guide
SSL2 Extended Capabilities User’s Guide II
Visual Analyzer User’s Guide

Help Files
WiSK Help
f90SQL-Lite Help

Newsletters
The Lahey FortranSourcenewsletter

Lahey Web Page
http://www.lahey.com
Lahey/Fujitsu Fortran 95 User’s Guide 9
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This chapter describes how to use Lahey/Fujitsu Fortran 95. It presents an overview of
development process and describes how to build Fortran applications using the LF95 d
The driver controls compilation, linking, and the production of executable programs an
dynamic link libraries (DLLs).

The Development Process
Developing applications with LF95 involves the following tools:

Editor. Use the Lahey ED development environment to create or modify Fortran source f
The driver can be run from within the editor. Compiler error messages are automatica
keyed to lines of source code. ED also integrates debugging facilities for Windows app
tions. See Chapter 3,Editing and Debugging with ED, for instructions on using Lahey ED.

Library Manager. Use the library manager to create, change, and list the contents of ob
libraries. See Chapter 6,LM Librarian, for instructions on how to use the library manager.

Automake.Use the Automake utility to automate program creation. This is especially use
if your program consists of multiple files. See Chapter 7,Automake, for instructions on how
to use Automake.

Debuggers.For Windows console and GUI applications use FDB or WinFDB to debug yo
code (See Chapter 4,Command-Line Debugging with FDBand Chapter 5,Windows Debug-
ging with WinFDB).

Driver. Use the driver (LF95.EXE ) to control the creation of object files, libraries, execut-
able programs, and DLLs.LF95.EXE is often referred to as the compiler, bit it is actually a
driver that invokes the compiler, linker, and other components used to create executab
libraries, and other products.

The remainder of this chapter focuses on the driver and the processes it controls.
Lahey/Fujitsu Fortran 95 User’s Guide 11
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How the Driver Works
The driver (LF95.EXE ) controls the two main processes—compilation and linking—used
create an executable program. Two supplemental processes, creating import libraries
processing Windows resources, are sometimes used depending on whether you are cr
a DLL or a 32-bit Windows program. These processes are performed by the following p
grams under control of the driver:

Compiler. The compiler compiles source files into object files and creates files required
using Fortran 90 modules and files needed by the linker for creating DLLs.

Library Manager . LM.EXE is the library manager. It can be invoked from the driver or from
the command prompt to create or change static libraries.

Linker. 386LINK.EXE is the linker. The linker combines object files and libraries into a si
gle executable program or dynamic link library. The linker also adds Windows resource
like icons and cursors, into Windows executables.

Import library manager. Import library managers are provided with various 32-bit Win-
dows user interface tools. From definition files output by the compiler, an import library
manager creates import libraries for use with LF95 dynamic link libraries (DLLs).

Resource Compiler.RC.EXE is the resource compiler. It converts Windows resource file
(.RC files) to.RES files. .RES files are converted byRES2OBJ.EXEinto object files.

Running LF95
To run the driver, typeLF95 followed by a list of one or more file names and optional com
mand-line switches:

LF95 filenames [switches]

The driver searches for the various tools (the compiler, library manager, linker, import lib
manager, and resource compiler) first in the directory the driver is located and then, if n
found, on the DOS path. The command line switches are discussed later in this chapte

Filenames
Depending on the extension(s) of the filename(s) specified, the driver will invoke the ne
sary tools. The extensions.F95 ,.F90 ,.FOR, and.F , for example, cause the compiler to be
invoked. The extension.OBJ causes the linker to be invoked; the extension.RC causes the
resource compiler,RES2OBJ, and the linker to be invoked..RES causesRES2OBJand the
linker to be invoked.

Filenames containing spaces must be enclosed in quotes.
12 Lahey/Fujitsu Fortran 95 User’s Guide
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Note: the extension.MODis reserved for compiler-generated module files. Do not use th
extension for your Fortran source files.

Source Filenames
One or more source filenames may be specified, either by name or using the DOS wildc
* and?. Filenames must be separated by a space.

Example
LF95 *.f90

If the filesONE.F90, TWO.F90, andTHREE.FORwere in the current directory,ONE.F90 and
TWO.F90 would be compiled and linked together, and the stub-bound executable file,
ONE.EXE, would be created because the driver foundONE.F90 beforeTWO.F90 in the cur-
rent directory.THREE.FORwould not be compiled because its extension does not match
extension specified on the LF95 command line.

Source filenames are specified as a complete file name or can be given without an exten
in which case LF95 supplies the default extension.F90 . In the absence of a switch specify
ing otherwise:

.F90 specifies interpretation as Fortran 90 free source form.

.FOR and.F specify interpretation as Fortran 90 fixed source form.

If files with both the.FOR or .F and.F90 appear on the same command line, then all are
assumed to use the source form the driver assumes for the last file specified.

The-fix and-nfix compiler switches can be used to control the assumed extension a
override the interpretation specified by the extension. see“-[N]FIX” on page 23

Object Filenames
The default name for an object file is the same as the source file name. If a path is spec
for the source filename, the same path will be used for the object file name. If no path is s
ified, the current directory will be used.

Output Filenames
The default name for the executable file or dynamic link library produced by the driver i
based on the first source or object name encountered on the command line. This may be
ridden by specifying the-OUT switch with a new name. see“-OUT filename” on page 29
The default extension for executable files is.EXE . The default extension for dynamic link
libraries is.DLL .

Switches
The driver recognizes one or more letters preceded by a hyphen (- ) as a command-line
switch. You may not combine switches after a hyphen: for example,-x and-y may not be
entered as-xy .
Lahey/Fujitsu Fortran 95 User’s Guide 13
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Some switches take arguments in the form of filenames, strings, letters, or numbers. Y
must enter a space between the option and its argument(s).

Example
-i incdir

If an unknown switch is detected, the entire text from the beginning of the unknown sw
to the beginning of the next switch or end of the command line is passed to the linker.

Conflicts Between Switches
Command line switches are processed from left to right. If conflicting switches are speci
the last one specified takes precedence. For example, if the command line containedLF95

foo -g -ng , the-ng switch would be used.

To display the LF95 version number and a summary of valid command-line options, typ
LF95 without any command-line switches or filenames.

Driver Configuration File (LF95.FIG)
In addition to specifying switches on the command line, you may specify a default set o
switches in theLF95.FIG file. When the driver is invoked, the switches in theLF95.FIG

file are processed before those on the command line. Command-line switches override
in theLF95.FIG file. The driver searches forLF95.FIG first in the current directory and
then, if not found, in the directory in which the driver is located.

Command Files
If you have too many switches and files to fit on the command line, you can place them
command file. Enter LF95 command line arguments in a command file in exactly the s
manner as on the command line. Command files may have as many lines as needed.
beginning with an initial# are comments.

To process a command file, preface the name of the file with an@character. When LF95
encounters a filename that begins with@on the command line, it opens the file and process
the commands in it.

Example
LF95 @mycmds

In this example, LF95 reads its commands from the filemycmds.

Command files may be used both with other command-line switches and other comma
files. Multiple command files are processed left to right in the order they are encounter
14 Lahey/Fujitsu Fortran 95 User’s Guide
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Passing Information
The LF95 driver uses temporary files for sending information between the driver and pr
cesses it controls. These files are automatically created using random names and are d

Return Codes from the Driver
When the LF95 driver receives a failure return code, it aborts the build process. The dr
will return an error code depending on the success of the invoked tools. These return c
are listed below:

Creating a Console-Mode Application
To create a Windows console-mode executable that will run on Windows 95, Windows
or Windows NT, no switches need be specified.

Example
LF95 MYPROG.F90

Table 1: Driver Return Codes

Code Condition

0 Successful compilation and link

1 Compiler fatal error

2 Library Manager error

3 Linker error

4 Driver error

5 Help requested

8 RES2OBJerror

9 Resource compiler error
Lahey/Fujitsu Fortran 95 User’s Guide 15
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Creating a Windows GUI application
To create a Windows GUI application, either with a third-party package (such as Wintera
GINO, or RealWin) or by calling the Windows API’s directly, specify the-win switch. To
call the Windows API’s directly, you must also specify the-ml winapi switch (see”-ML
target” on page 28 and”Calling the Windows API” on page 48 for more information).

Example
LF95 MYPROG.F90 -win

Creating a W iSK Application
To create a 32-bit Windows program using routines from the WiSK library, specify the
-wisk switch along with the name of a resource file created with DialogEd and MenuE

Example
LF95 myprog.f90 myrc.rc -wisk

In this example, the source fileMYPROG.F90contains calls to the WiSK library andMYRC.RC

contains resource definitions created by MenuEd and DialogEd. The following takes p

1. MYPROG.F90is compiled to createMYPROG.OBJ.
2. MYRC.RCis compiled to createMYRC.RES.
3. MYRC.RESis processed by RES2OBJ to createMYRC.OBJ.
4. MYPROG.OBJandMYRC.OBJare automatically linked with the LF95 runtime library

andWISK.LIB, to createMYPROG.EXE, a 32-bit Windows executable.

Creating a 32-bit Windows DLL
To create a 32-bit Windows DLL, use the-dll switch.

Example
LF95 myprog.f90 -dll -win -ml msvc

In this example, the source fileMYPROG.F90contains routines with DLL_EXPORT state-
ments. The following takes place:

1. MYPROG.F90is compiled to createMYPROG.OBJ.
2. MYPROG.OBJis automatically linked with the LF95 runtime library to create

MYPROG.DLLandMYPROG.LIB, the corresponding import library. Calling conven-
tions in this case are those expected by Microsoft Visual C/C++.

For more information on DLLs, see”Using DLLs” on page 38.
16 Lahey/Fujitsu Fortran 95 User’s Guide
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Controlling Compilation
During the compilation phase, the driver submits specified source files to the compiler
compilation and optimization. If the-c , compile only, switch is specified, processing will
stop after the compiler runs and modules are created (if necessary). See”-[N]C” on page
19. Otherwise, processing continues with linking and possibly import library creation.

Errors in Compilation
If the compiler encounters errors or questionable code, you may receive any of the follow
types of diagnostic messages (a letter precedes each message, indicating its severity)

U:Unrecoverable error messages indicate it is not practical to continue
compilation.

S:Seriouserror messages indicate the compilation will continue, but no object file
will be generated.

W:Warning messages indicate probable programming errors that are not serious
enough to prevent execution. Can be suppressed with the -nw or -swm switch.

I:Informational messages suggest possible areas for improvement in your code and
give details of optimizations performed by the compiler. These are normally sup-
pressed, but can be seen by specifying the -info switch (see”-[N]INFO” on page
25).

If no unrecoverable or serious errors are detected by the compiler, the DOSERRORLEVELis
set to zero (see”Return Codes from the Driver”on page 15). Unrecoverable or serious
errors detected by the compiler (improper syntax, for example) terminate the build proc
An object file is not created.

Compiler and Linker Switches
You can control compilation and linking by using any of the following option switches.
These switches are not case sensitive. Some switches apply only to the compilation ph
others to the linking phase, and still others (-g, -win, and -wisk) to both phases; this is in
cated next to the name of the switch. If compilation and linking are performed separately
in separate command lines), then switches that apply to both phases must be included in
command line.

Compiling and linking can be broken into separate steps using the -c switch. Unless th
switch is specified, the LF95 driver will attempt to link and create an executable after th
compilation phase completes. Specifying -c anywhere in the command line will cause t
link phase to be abandoned and all linker switches to be ignored.
Lahey/Fujitsu Fortran 95 User’s Guide 17
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Note also that linker switches may be abbreviated as indicated by the uppercase charac
the switch name. For example, the-LIBPath switch can be specified as either-libpath

or -libp. Some linker switches require a number as an argument. By default, all num
are assumed to be decimal numbers. A different radix can be specified by appending a
specifier to the number. The following table lists the bases and their radix specifiers:

The underscore character (‘_’) can be used in numbers to make them more readable:
80000000h is the same as8000_0000h .

-[N]AP
Arithmetic Precision
Compile only. Default: -nap

Specify -ap to guarantee the consistency of REAL and COMPLEX calculations, regard
of optimization level; user variables are not assigned to registers. Consider the followin
example:

Example
X = S - T

2 Y = X - U
...
3 Y = X - U

By default (-nap), during compilation of statement 2, the compiler recognizes the value
already in a register and does not cause the value to be reloaded from memory. At state
3, the value X may or may not already be in a register, and so the value may or may no
reloaded accordingly. Because the precision of the datum is greater in a register than in
ory, a difference in precision at statements 2 and 3 may occur.

Specify -ap to choose the memory reference for non-INTEGER operands; that is, regis
are reloaded. -ap must be specified when testing for the equality of randomly-generate
values.

The default, -nap, allows the compiler to take advantage of the current values in registe
with possibly greater accuracy in low-order bits.

Specifying -ap will usually generate slower executables.

Table 2: Radix Specifiers

Base Radix Specifier Example of 32 in base

2 B or b 10000b

8 Qor q 40q

10 none 32

16 H or h 20h
18 Lahey/Fujitsu Fortran 95 User’s Guide
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-[NO]BANNER

Linker Banner

Link only. Default: -banner

-banner displays a 386|LINK copyright message with the 386|LINK version and serial

number. -nobanner suppresses the 386|LINK copyright message.

-BLOCK blocksize

Default blocksize

Compile only. Default: 8192 bytes

Specify-block to default to a specific blocksize on OPEN statements. See “blocksize” in

the LF95 Language Reference.blocksizemust be a decimal INTEGER constant. Specifyin

an optimalblocksizecan make an enormous improvement in the speed of your executab

The programTRYBLOCK.F90in theSRCdirectory demonstrates how changing blocksize ca
affect execution speed. Some experimentation withblocksizein your program is usually nec-

essary to determine the optimal value.

-[N]C

Suppress Linking

Compile only. Default:-nc

Specify-c to create object (.OBJ ), and, if necessary, module (.MOD) files without creating

an executable. This is especially useful in makefiles (see”Automake” on page 101), where

it is not always desirable to perform the entire build process with one invocation of the dr

-[N]CHK

Checking

Compile only. Default:-nchk

Specify-chk to generate a fatal runtime error message when substring and array subsc
are out of range, when non-common variables are accessed before they are initialized,

array expression shapes do not match, and when procedure arguments do not match in

attributes, size, or shape.

Syntax

- [n]chk [ ( [ a][ ,e ][ ,s ][ ,u ][ ,x ] ) ]
Lahey/Fujitsu Fortran 95 User’s Guide 19
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Note: Commas are optional, but are recommended for readability.

Specifying-chk with no arguments is equivalent to specifying-chk (a,e,s,u) . Specify
-chk with any combination ofa, e, s , u andx to activate the specified diagnostic checking
class.

Specification of the argument x must be used for compilation of all files of the program,
incorrect results may occur. Do not use with 3rd party compiled modules, objects, or lib
ies. Specifically, thex argument must be used to compile all USEd modules and to comp
program units which set values within COMMONs. Specifying the argumentx will force
undefined variables checking (u), and will increase the level of checking performed by an
other specified arguments.

Specifying-chk adds to the size of a program and causes it to run more slowly, sometim
as much as an order of magnitude. It forces-trace and removes optimization by forcing
-o0 .

Example
LF95 myprog -chk (a,x)

instructs the compiler to activate increased runtime argument checking and increased
fined variables checking.

The -chk switch will not check bounds in the following conditions:

• The referenced expression has the POINTER attribute or is a structure one or more
of whose structure components has the POINTER attribute.

• The referenced expression is an assumed-shape array.
• The referenced expression is an array section with vector subscript.
• The referenced variable is a dummy argument corresponding to an actual argumen

that is an array section.
• The referenced expression is in a masked array assignment.
• The referenced expression is in a FORALL statements and constructs.
• The referenced expression has the PARAMETER attribute.
• The parent string is a scalar constant.

Table 3: -chk Arguments

Diagnostic Checking Class Switch Argument

Arguments a

Array Expression Shape e

Subscripts s

Undefined variables u

Increased (extra) x
20 Lahey/Fujitsu Fortran 95 User’s Guide
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-[N]CHKGLOBAL
Global Checking
Compile only. Default:-nchkglobal

Specify-chkglobal to generate compiler error messages for inter-program-unit diagno
tics, and to perform full compile-time and runtime checking.

The global checking will only be performed on the source which is compiled within one in
cation of the compiler (the command line). For example, the checking will not occur on
USEd module which is not compiled at the same time as the source containing the USE
ment, nor will the checking occur on object files or libraries specified on the command

Because specifying-chkglobal forces-chk (x) , specification of-chkglobal must be
used for compilation of all files of the program, or incorrect results may occur. Do not u
with 3rd-party-compiled modules, objects, or libraries. See the description of -chk for m
information.

Global checking diagnostics will not be published in the listing file. Specifying-chkglobal

adds to the size of a program and causes it to run more slowly, sometimes as much as an
of magnitude. It forces-chk (a,e,s,u,x) , -trace , and removes optimization by forcing
-o0 .

-[N]CO
Compiler Options
Compileand link. Default: -co

Specify-co to display current settings of compiler options; specify-nco to suppress them.

-[N]COVER
Coverage Information
Compileand link. Default: -ncover

Specify-cover to generate information for use by the coverage tool (see Chapter 9,The
Coverage Tool). This switch is required to run the coverage tool if a separate link is
performed.

-[N]DAL
Deallocate Allocatables
Compile only. Default:-dal

Specify-dal to deallocate allocated arrays that do not appear in DEALLOCATE or SAV
statements when a RETURN, STOP, or END statement is encountered in the program
containing the allocatable array. Note that-ndal will suppress automatic deallocation, even
for Fortran 95 files (automatic deallocation is standard behavior in Fortran 95).

-[N]DBL
Double
Compile only. Default:-ndbl
Lahey/Fujitsu Fortran 95 User’s Guide 21
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Specify-dbl to extend all single-precision REAL and single-precision COMPLEX vari-
ables, arrays, constants, and functions to REAL (KIND=8) and COMPLEX (KIND=8)
respectively. If you use-dbl , all source files (including modules) in a program should be
compiled with-dbl . Specifying-dbl will usually result in somewhat slower executables

-[N]DLL
Dynamic Link Library
Link only. Default: -ndll

Specify-dll , -ml , and-win to create a 32-bit Windows dynamic link library (for more
information, see”Using DLLs” on page 38).

-[N]F90SQL
Use f90SQL Lite
Compile and link. Default:-nf90sql

Specify-f90sql to create an application using f90SQL Lite.

-[N]F95
Fortran 95 Conformance
Compile only. Default:-nf95

Specify-f95 to generate warnings when the compiler encounters non-standard Fortran
code.

Note that-nf95 allows any intrinsic data type to be equivalenced to any other.

-FILE filename
Filename
Compileand link. Default: not present

Precede the name of a file with-file to ensure the driver will interpret the filename as th
name of a file and not an argument to a switch.

Example
On the following command line,bill.f90 is correctly interpreted as a source file:

LF95 -checksum -file bill.f90

On this next command line,bill.f90 is not recognized as a source file. The driver pass
the unrecognized switch,-checksum , to the linker and assumes the following string,
“bill.f90 ”, is an argument to the-checksum switch.

LF95 -checksum bill.f90

On this last command line,-file is not necessary. The order of driver arguments allows
unambiguous interpretation:

LF95 bill.f90 -checksum
22 Lahey/Fujitsu Fortran 95 User’s Guide
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-[N]FIX
Fixed Source Form
Compile only. Default:-nfix for .f90 and.f95 files; -fix for .for or .f files

Specify-fix to instruct the compiler to interpret source files as Fortran 90 fixed source for
-nfix instructs the compiler to interpret source files as Fortran 90 free source form.

Example
LF95 @bob.rsp bill.f90

If the command fileBOB.RSPcontains-fix , BILL.F90 will be interpreted as fixed source
form even though it has the free source form extension.F90 .

LF95 assumes a default file extension of.f90 . Specifying-fix causes LF95 to assume a
default file extension of.for .

All source files compiled at the same time must be fixed or free. LF95 doesn’t compile f
(including INCLUDEfiles) containing both fixed and free source form.

-[N]G
Debug
Compileand link. Default: -ng

Specify-g to instruct the compiler to generate an expanded symbol table and other info
tion for the debugger.-g automatically overrides any optimization switch and forces-o0 ,
no optimizations, so your executable will run more slowly than if one of the higher optim
zation levels were used.-g is required to use the debugger. Supplemental debug informat
is stored in a file having the same name as the executable file with extension .YDG. If
following error message appears during linking

fwdmerg:[error] Terminated abnormally. (signal 11)

It means that the .YDG file was not created (contact Technical Support if this happens)

This switch is required to debug if a separate link is performed.

-I path
Include Path
Compile only. Default: current directory

Specify-i pathto instruct the compiler to search the specified path(s) for FortranINCLUDE

files after searching the current directory. Separate multiple search paths with a semic
no spaces.

Example
LF95 demo -i ..\project2\includes;..\project3\includes

In this example, the compiler first searches the current directory, then searches
..\project2\includes and finally ..\project3\includes for INCLUDEfiles speci-
fied in the source fileDEMO.F90
Lahey/Fujitsu Fortran 95 User’s Guide 23
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-IMPLIB
Specify DLL Library

Link only. Default: not specified.

The-implib switch specifies the name of the dynamic link library from which a progra
has called functions listed in one or more subsequent-import switches. The library speci-
fied in the-implib switch is valid for all modules specified in any number of subsequen-

import switches, until the specification of another-implib switch.

Syntax
-IMPLIB libname

wherelibnameis the name and path of the DLL library from which to import functions usin
subsequent-import statements.

Example
LF95 main -implib mydll -import myfunc1,myfunc2

LF95 main -implib A -import A1 -implib B -import B1,B2,B3

-IMPORT
Import a DLL Function

Link only. Default: not specified.

Syntax
-IMPORT dllname.funcname

or
-IMPORT anyfunc=dllname.funcname

wheredllnameis the DLL library from which to import the function,funcnameis the name
of the function being imported, andanyfuncis an alias for the name of the actual function
(the alias is useful for handling differences in naming conventions). The name of the D
library can be omitted if it was specified previously with the-implib switch.

Example
LF95 main -import mathlib.getnum mathlib.tan

LF95 main -import _getnum@12=mathlib.getnum

LF95 main -implib mathlib -import _getnum@12=getnum

-[N] IN
Implicit None

Compile only. Default:-nin

Specifying-in is equivalent to including an IMPLICIT NONE statement in each program
unit of your source file: no implicit typing is in effect over the source file.

When-nin is specified, standard implicit typing rules are in effect.
24 Lahey/Fujitsu Fortran 95 User’s Guide
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-[N]INFO
Display Informational Messages
Compile only. Default:-ninfo

Specify-info to display informational messages at compile time. Informational messa
include such things as the level of loop unrolling performed, variables declared but nev
used, divisions changed to multiplication by reciprocal, etc.

-[N]LI
Lahey Intrinsic Procedures
Compile and link. Default:-li

Specify-nli to avoid recognizing non-standard Lahey intrinsic procedures.

-Lib filename
Library
Link only. Default: none

The-Lib switch specifies one or more library files. The names of the library files imme
ately follow the switch, separated by either spaces or commas. If no filename extensio
specified for a library file, the linker assumes the extension,.LIB .

The-Lib switch may be used multiple times in a single linker command string. The link
builds a list of the library files and processes them in the order they were specified on t
command line.

To create and maintain libraries of commonly-used functions, use the LM library manag
See Chapter 6,LM Librarian.

Syntax
-Lib lib1[,lib2 ...]

lib1 andlib2 are one or more library files.

Example
LF95 hello.obj -lib mylib

-LIBPath path
Library Path
Link only. Default: current directory.

The-LIBPath switch allows specification of one or more directories to be searched for
libraries. Note that all necessary library files must still be called out in the command lin

Syntax
-LIBPath dir1[,dir2 ...]

dir1 anddir2 are one or more directories to be searched.
Lahey/Fujitsu Fortran 95 User’s Guide 25
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Example
LF95 main.obj -libpath d:\mylibs -lib mine.lib -pack

LF95 main.obj -libp d:\mylibs,e:\yourlibs -lib mine,yours

Directory names specified for-LIBPath must not end with a “\ ” delimiter. The linker will
affix the directory delimiter to the file name being sought.

-[N]LONG
Long Integers

Compile only. Default:-nlong

Specify-long to extend all default INTEGER variables, arrays, constants, and function
INTEGER (KIND=8). If you use-long , all source files (including modules) in a program
should be compiled with-long .

-[N]LST
Listing

Compile only. Default:-nlst

Specify-lst to generate a listing file that contains the source program, compiler option
date and time of compilation, and any compiler diagnostics. The compiler outputs one lis
file for each source file specified. By default, listing file names consist of the root of the
source file name plus the extension.lst .

Syntax
- [n] lst [ ( spec=sval[, spec = sval] ...) ]

Where:

specis f for the listing file name, ori to include INCLUDE files.

For f =sval, the listing file name,svalspecifies the listing file name to use instead of the
default. If a file with this name already exists, it is overwritten. If the file can't be overw
ten, the compiler aborts. If the user specifies a listing file name and more than one sou
file (possibly using wild cards) then the driver diagnoses the error and aborts.

For i =sval, svalis one of the characters of the set [YyNn], whereY andy indicate that include
files should be included in the listing andN andn indicate that they should not. By default,
include files are not included in the listing.

Example
LF95 myprog -lst (i=y)

creates the listing filemyprog.lst , which lists primary and included source. Note that
-xref overrides-lst .

See also

-[N]XREF
26 Lahey/Fujitsu Fortran 95 User’s Guide
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-[NO]Map filename
Map File
Link only. Default: -map

The linker map file is a text file describing the output load image. The map file contains
following information:

• command switches specified when the program was linked,
• names of the input object files,
• a list of the segments comprising the program, and
• a list of the public symbols in the program.

By default, the linker produces a map file each time a program is linked. The default na
of the map file is the name of the output file, with its extension changed to.MAP. Any path
information specifying a directory where the output file is to be placed also applies to the
file.

The-Map switch renames or relocates the map file. The switch takes a single argumen
which is the path and name of the map file to be produced. If no file name extension is s
ified, then a default of.MAP is assumed. If no path information is specified in the map file
name, then it is placed in the current directory.

The linker can be prevented from producing a map file with the-NOMapswitch. The switch
takes no arguments. The-NOMapswitch is useful to make the linker run faster, since no tim
is spent writing the map file. The switch is also a good way to save disk space, because
files can become quite large.

Syntax
-Map filename

Example
LF95 moe.obj larry.obj curly.obj -m stooges
LF95 hello.obj -nom

-MAPNames nchars
Mapfile Name Length
Link only. Default: -mapnames 12

The-MAPNamesswitch controls the length of global symbol names displayed in the map fi
By default, segment, group, class, module, and public symbol names are truncated to 12
acters in the map file. The switch takes a numeric constant argument which increases
length of global symbols in the map file to the specified number of characters.

Increasing the symbol name length may cause the default maximum line width of 80 ch
ters to be exceeded. If this occurs, the linker prints less information about segments an
public symbols. This loss of information can be prevented by using the-MAPWidth switch.

Syntax
-MAPNames nchars
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ncharsis the length of global symbols in the map file, expressed as number of characte

Example
LF95 hello.obj -mapn 30

-MAPWidth nchars
Mapfile Line Width
Link only. Default: -mapwidth 80

The-MAPWidth switch controls the maximum line width in the program map file. The
switch takes a numeric constant argument which is the new maximum width for lines in
map file.

Syntax
-MAPWidth nchars

ncharsis the maximum line width in the map file, expressed as number of characters.

Example
LF95 hello.obj -mapn 30 -mapw 120

-[N]MAXFATALS number
Maximum Number of Fatal Errors
Compile only. Default:-maxfatals 50

Specify-maxfatals to limit the number of fatal errors LF95 will generate before abortin

-ML target
Mixed Language
Compile only. Default:-ml lf95

Specify the-ml switch if your code calls or is called by code written in another language
if your code will call routines in DLLs created by LF95.-ml affects name mangling for rou-
tine names in DLL_IMPORT, DLL_EXPORT, and ML_EXTERNAL statements. See
”Mixed Language Programming”on page 38 for more information.

Syntax
-ML target

Where:
target is bc for Borland C++;bd for Borland Delphi; msvb for Microsoft Visual Basic;
msvc for Microsoft Visual C++; fc for Fujitsu C;LF95 for LF95; LF90 for LF90; and
winapi for accessing the Windows API directly.

-MLDEFAULT target
Mixed Language Default
Compile only. Default:-mldefault
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Specify the -mldefault switch to set the default target language name decoration/calling
vention for all program units.-mldefault affects name mangling for routine names in
DLL_IMPORT, DLL_EXPORT, and ML_EXTERNAL statements.

Syntax
-MLDEFAULT target

Where:
target is bc for Borland C++;bd for Borland Delphi; msvb for Microsoft Visual Basic;
msvc for Microsoft Visual C++; fc for Fujitsu C; LF95 for LF95; LF90 for LF90; and
winapi for accessing the Windows API directly.

-MOD path
Module Path
Compile only. Default: current directory

Specify-mod pathto instruct the compiler to search the specified directory for LF95 modu
files (.MOD). New module and module object files will be placed in the first directory spe
ified by path. Note that any moduleobjectfiles needed from previous compilations must b
added to the LF95 command line.

Example
LF95 modprog mod.obj othermod.obj -mod ..\mods;..\othermods

In this example, the compiler first searches..\mods and then searches..\othermods .
Any module and module object files produced frommodprog.f90 are placed in..\mods .

-O0 and -O1
Optimization Level
Compile only. Default:-o1

Specify-o0 to perform no optimization.-o0 is automatically turned on when the-g option
or the-chk option is specified. see“-[N]G” on page 23

Specify-o1 to perform full optimization.

-O filename
Object Filename
Compile only. Default: name of the source file with the extension.OBJ

Specify-o nameto override the default object file name. The compiler produces an obj
file with the specified name. If multiple source file names are specified explicitly or by wi
cards,-o causes the driver to report a fatal error..

-OUT filename
Output Filename
Link only. Default: the name of the first object or source file, with the.EXE or .DLL exten-
sion. The output file is not automatically placed in the current directory. By default it is
placed in the same directory as the first object file listed on the command line.
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This switch takes a single argument, which is the path and name of the output file. If the
extension.EXE is specified, an executable file will be created. If the file extension.DLL is
specified, a dynamic-link library will be created. If the file extension.LIB is specified, a
static library will be created. If no extension is specified,.EXE is assumed with -ndll;.DLL

is assumed with-dll . If the -dll switch is specified,.DLL is assumed. If no path informa-
tion is specified with the file name, then the output file is placed in the current directory

Example
LF95 hello.obj -out d:\LF95\hello.exe

LF95 main.obj -out maintest

-[N]PAUSE
Pause After Program Completion
Compile only. Default:-npause

Specifying-pause will cause the executable program to wait for a keystroke from the us
at program completion, before returning to the operating system. This switch can be us
keep the console window from vanishing at program completion, thereby allowing the u
to view the final console output. A console window will vanish at program completion if t
program is invoked from Windows Explorer or the Start menu, or if the console is gener
by a Windows GUI application.

See also
-WIN or -WINCONSOLE

-[N]PCA
Protect Constant Arguments
Compile only. Default:-npca

Specify-pca to prevent invoked subprograms from storing into constants.

Example
call sub(5)

print *, 5

end

subroutine sub(i)

i = i + 1

end

This example would print 5 using -pca and 6 using -npca.

-[N]PRIVATE
Default Module Accessibility
Compile only. Default:-nprivate

Specify-private to change the default accessiblity of module entities from PUBLIC to
PRIVATE (see“PUBLIC” and “PRIVATE” statements in the Language Reference).
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-PUBList option
Map File Symbol Sort Order

Link only. Default: -publist byname

The-PUBList switch controls the ordering of the list of public symbols in the map file. Th
-PUBList switch has options to control the ordering of public symbols. They are:

Syntax
-PUBList BYNAME

-PUBList BYVALUE

-PUBList BOTH

-PUBList NONE

Example
LF95 hello.obj -publ byvalue

-[N]QUAD
Quad Precision

Compile only. Default:-nquad

Specify-quad to extend all double-precision REAL and double-precision COMPLEX va
ables, arrays, constants, and functions to REAL (KIND=16) and COMPLEX (KIND=16)
respectively. If you use-quad , all source files (including modules) in a program should b
compiled with-quad . Specifying-quad will usually result in significantly slower execut-
ables. All exceptions will be trapped by default. This behavior can be overridden using
NDPEXC routine or the ERRSET service routine (see the file SERVICE.TXT).

-[N]SAV
SAVE Local Variables

Compile only. Default:-nsav

Table 4: -PUBList Options

BYNAME
Sort the list of public symbols which make up the program alphabetically.

This is the default operation of the linker.

BYVALUE

Sort the list of public symbols in the program by value. This option is use-
ful when using the map file to find out what routine or variable resides at a

particular memory location.

BOTH
Produce two listings of the public symbols: one sorted alphabetically and

one sorted by value.

NONE
Cause the linker not to list the public symbols which make up the program

at all. This option is useful for reducing the size of the map file.
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Specify-sav to allocate local variables in a compiler-generated SAVE area.-nsav allo-
cates variables on the stack.-sav is equivalent to having a SAVE statement in each
subprogram except that-sav does not apply to local variables in a recursive function
whereas the SAVE statement does. Specifying-sav will cause your executable to run more
slowly, especially if you have many routines. Specifying-nsav may sometimes require
more than the default stack (see”-Stack” on page 32).

-[N]STATICLINK
Static Link
Compileand link. Default: -nstaticlink

Specify -staticlink with -win and-ml to link statically with code produced by another
supported language system. See”Mixed Language Programming”on page 38 for more
information.

-Stack
Stack Size
Link only. Default:100000h bytes (link only)

The-Stack switch specifies the size of the stack area for a program. The switch must
followed by a numeric constant that specifies the number of bytes to be allocated to the

If a stack segment is already present in the program, then the-Stack switch changes the size
of the existing segment. The linker, however, will only increase the size of the existing s
area. If an attempt is made to decrease the size of the stack area, the linker issues an

If your program runs out of stack at runtime, increase the stack size with-Stack . Stack
requirements are noted in the listing file (see“-[N]LST” on page 26) Note that some recur
sive procedures and files with large arrays compiled with-nsav can use very large amounts
of stack.

Syntax
-Stack nbytes

Example
LF95 hello.obj -s 200000

-[N]STCHK
Stack Overflow Check
Compile only. Default:-stchk

Specify-nstchk to cause the compiler not to generate code for stack overflow checkin
Though your program may execute faster, the stack is not protected from growing too l
and corrupting data.

-[N]SWM msgs
Suppress Warning Message(s)
Compile only. Default:-nswm
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To suppress a particular error message, specify its number after-swm.

Example
-swm 16,32

This example would suppress warning messages 16 and 32. To suppress all warnings
-nw .

-T4, -TP, and -TPP
Target Processor
Compile only. Default: set on installation

Specify-t4 to generate code optimized for the Intel 80386 or 80486 processor.

Specify-tp to generate code optimized for the Intel Pentium or Pentium MMX processo
or their generic counterparts.

Specify-tpp to generate code optimized for the Intel Pentium Pro, Pentium II, Pentium
or Celeron processors, or their generic counterparts. Please note: code generated with-tpp

is not compatible with processors made earlier than the Pentium Pro.

-[N]TRACE
Location and Call Traceback for Runtime Errors
Compile only. Default:-trace

The-trace switch causes a call traceback with routine names and line numbers to be
erated with runtime error messages. With-ntrace no line numbers are generated, and th
Sampler tool cannot be used (the Sampler tool requires line number information -- see C
ter 8,The Sampler Tool).

-[N]TRAP exceptions
Trap NDP Exceptions
Compile only. Default:-ntrap

The-trap switch specifies how each of four numeric data processor (NDP) exceptions
be handled at execution time of your program.

Table 5: NDP Exceptions

NDP Exception Switch Argument

Divide-by-Zero d

Invalid Operation i

Overflow o

Underflow u
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Specify-trap with any combination ofd, i , o, andu to instruct the NDP chip to generate
an interrupt when it detects the specified exception(s) and generate an error message.
that trapping cannot be disabled when-quad is specified, except by using the NDPEXC
routine or the ERRSET service routine (see the file SERVICE.TXT)

Syntax
-TRAP [d][ i][ o][ u]

Where:
the d, i, o, and u arguments can be used in any combination, as exlained above.

-TwoCase and -OneCase
Linker Case Sensitivity
Link only. Default: -onecase

For-OneCase , the linker ignores the case of public symbols that make up the program be
linked. For example, the symbolsabc , ABC, andaBc are equivalent in the linker.

The-TwoCase switch enables case-sensitive processing of user-defined symbols. When
switch is used, upper- and lower-case versions of the same symbol are considered to b
ferent. -win forces-TwoCase .

-OneCase enforces default behavior.

Example
LF95 hello.obj -lib \LF95\graph90 -tc

-[N]VSW
Very Simple Windows
Compileand link. Default: -nvsw

The-vsw switch creates a simple console-like Windows GUI application. The window
scrollable.

-[N]W
Warn
Compile only. Default:-w

Specify-w to generate compile warning and informational messages.

-[NO]WARN and -FULLWARN
Warning Detail
Link only. Default: -warn

The linker detects some conditions that can potentially cause run-time problems but ar
necessarily errors. Warning messages for these conditions can optionally be generated
display and in the map file. The linker supports three warning levels:-WARN, -FULLWARN,
and-NOWARN.

-WARNenables basic linker warning messages.
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-FULLWARNenables additional warning messages for the following conditions:

• Multiple initializations of common blocks with different values. The last object
module processed is the one that supplies initial values to the output file.

• Pieces of a single segment from different object modules having different segment
attributes.

• Inconsistent segment grouping in different object modules.

-NOWARNdisables all linker warning messages.

Example
LF95 hello.obj -warn

-WIN or -WINCONSOLE
Windows
Compileand link. Default: -winconsole

Specify-win or -winconsole to create a 32-bit Windows application. Specifying-win-

console will create an application for Windows console mode. Viewing of console outp
may require that-pause also be specified in some cases. Under Windows 9x, the-win

switch can only be used for GUI applications, not console-mode applications (use -wincon-

sole for console-mode applications). The -win switch requires a WinMain.You can
accomplish this by one of the following methods: 1) Use the built-in WinMain in LF95 whi
will call your LF95 main program; 2) Set up your own WinMain using calls to the Window
API; 3) Build your user interface in another language where the WinMain is set up in th
other language (often without the user knowing it, as in Visual Basic and Delphi); 4) So
library packages such as Winteracter and RealWin include a WinMain.

-winconsole will put a Windows console (DOS box) on the screen if the program is
invoked from Windows explorer or the Start menu. If the program is invoked from the co
mand line of an existing console window, then all console I/O will be performed within th
window. In other words, a-winconsole program has the “look and feel” of a DOS program
running in a DOS box. This is your best choice if you need to see program results after a
gram run. Note that the console will disappear after program completion if the program
invoked from Windows explorer or the Start menu.

Console output with-win is allowed if your program is running on Windows NT. If your
program reads from or writes to standard output, a console will be created but the cons
will immediately disappear after your program runs to completion.

See also
-[N]PAUSE

-[N]WISK
Winteracter Starter Kit
Compile and link. Default:-nwisk (compile and link)
Lahey/Fujitsu Fortran 95 User’s Guide 35



Chapter 2 Developing with LF95

and

For-

ss

. If

e

am
Specify-wisk to create an application using theWinteracterStarter Kit (WiSK, see theWin-
teracterStarter Kit Manual). Note that a resource file name must be given on the comm
line whenever specifying-wisk . See theWinteracterStarter Kit manual for more
information.

-[N]WO
Warn Obsolescent
Compile only. Default:-nwo

Specify-wo to generate warning messages when the compiler encounters obsolescent
tran 90 features.

-[N]XREF
Cross-Reference Listing
Compile only. Default:-nxref

Specify-xref to generate cross-reference information in the listing file. By default, cro
reference file names consist of the root of the source file name plus the extension.lst .

Syntax
-[n] xref [ ( spec=sval[, spec=sval]...) ]

Where:
specis f for the listing file name, ori to include INCLUDE files.

For f =sval, the cross reference listing file name,svalspecifies the cross reference listing file
name to use instead of the default. If a file with this name already exists, it is overwritten
the file can't be overwritten, the compiler aborts.

For i =sval, svalis one of the characters of the set[YyNn] , whereY andy indicate that include
files should be included in the listing andN andn indicate that they should not. By default,
include files are not included in the listing.

Example
LF95 myprog -lst -xref(i=y)

creates the cross reference filemyprog.lst and outputs cross reference information for th
source file.

See also
-[N]LST

-[N]ZERO
Initialize Variables to Zero
Compile only. Default:-zero

Specifying-zero will cause all variables and data areas to be initialized to zero at progr
load time, if they are not already initialized by your Fortran code.
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Linking Rules
During this phase, the driver submits object files, object file libraries, and compiled resou
files (Windows only) to the linker for creation of the executable or dynamic link library.

Fortran 90 Modules
If your program uses Fortran 90 modules that have already been compiled, you must ad
module object filenames to the LF95 command line.

Searching Rules
The linker reads individual object files and object module libraries, resolves references
external symbols, and writes out a single executable file or dynamic link library. The lin
can also create a map file containing information about the segments and public symbo
the program.

If an object module or library was specified on the command line and contains path info
tion, then it must reside at the location specified. If the path was not specified, the linke
looks for the files in the following order:

1. in the current working directory
2. in any directories specified by the-LIBPath switch included in the386LINK envi-

ronment variable.
3. in any directories specified with the-LIBPath switch (note that-LIBPath searches

for library files only, not object modules).

Object File Processing Rules
Object modules specified as individual object files are processed in the order in which
appear on the command line.

Library Searching Rules
The order in which object modules from libraries are processed is not always obvious.
linker applies the following rules when searching object libraries:

1. Any libraries specified using the-Lib switch are searched in the order in which they
appear in the LF95 command string before the LF95 runtime library. The compiler
writes the LF95 default library names into each object file it generates.

2. Each library is searched until all possible external references, including backward
references within the library, are resolved.

3. If necessary, the linker recursively scans the list of libraries until all external refer-
ences are resolved.
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This algorithm is particularly important when two different object modules in two differe
libraries each have a public symbol with the same name. If both object modules are lin
the linker signals a duplicate symbol error because they both have public symbols whic
referenced elsewhere in the program. However, if the only symbol referenced in both o
modules is the duplicate symbol, then only the first object module encountered is linked
no error message is generated. In this latter case, the object module which actually ge
linked is determined by applying the rules listed above.

Mixed Language Programming
LF95 code can call and be called by code written in certain other languages. This can be
via dynamic linking (DLLs) or static linking.

Using DLLs
A Dynamic Link Library (DLL) is a collection of procedures packaged together as an ex
cutable file, not a library file. Even though it is in the form of an executable, a DLL cann
run on its own. The functions and subroutines in a DLL are called from a.EXE file that con-
tains a main program. Note that issuing a STOP statement from within a Fortran DLL w
cause the entire program to terminate.

With LF95 you can create 32-bit DLLs for use with the language systems in the table bel
Console I/O in the Fortran code is not recommended in Windows GUI applications, but
about everything else that is supported under Windows will work. Calls can be made f
Fortran to Fortran, from Fortran to another language, and from another language to For
If you are calling DLL routines from a language system other than LF95, please refer to
language system’s DLL documentation for more information.
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What Is Supported
Lahey/Fujitsu Fortran 95 supports DLL interfaces to the following languages and opera
systems (this list is subject to change—seeREAD_DLL.TXT for any changes):

Your assembly routines may be called from the Fortran routines, however the use of inte
21h is not supported. Refer toREADME.ASMfor more information regarding interfacing
LF95 with assembly code. LF95 can build DLLs callable from Microsoft Visual Basic.
Microsoft Visual Basic does not build DLLs callable by LF95.

Declaring Your Procedures
In order to reference a procedure across a DLL interface, the LF95 compiler must be
informed of the procedure name and told how to ‘decorate’ the external names in your D
The procedure names are defined with theDLL_EXPORTandDLL_IMPORTstatements (see
“DLL_EXPORT Statement” and “DLL_IMPORT Statement” in the LF95 Language Refer-
ence). Please note that in general, DLL procedure names arecase sensitive(unlike the Fortran
naming convention, which ignores case).DLL_EXPORTis used when defining a DLL and
DLL_IMPORTis used when referencing a DLL. The type of DLL interface is defined with th

Table 6: Compiler Support for Lahey DLLs

Language System Version

Lahey/Fujitsu LF95 5.0

Lahey LF90 2.01 and later

Borland C++ 4.5 and later

Borland Delphi 2.0 and later

Microsoft Visual C++ 2.0 and later

Microsoft Visual Basic 4.0 and later
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use of the-ML compiler switch. You cannot mix-ML options in a single invocation of LF95.
If you need to reference DLLs from multiple languages you can do so by putting the ref
ences in separate source files and compiling them separately. The-ML switch options are:

Building Fortran DLLs
When you create a Fortran DLL, you must indicate the procedures that you want to hav
available in the DLL with theDLL_EXPORTstatement. The procedures may be subroutin
or functions. When mixing languages, the function results must be of type default INTEG
REAL, or LOGICAL. The case of the name as it appears in theDLL_EXPORTand
DLL_IMPORTstatements is preserved for external resolution except when the-ML LF90

option is used; within the Fortran code the case is ignored, i.e.,Foo is the same asFOO.

To export a procedure from a Fortran DLL, use theDLL_EXPORTstatement, for example:

integer function half(x)

dll_export half !name is case-sensitive.

integer :: x

half = x/2

end

This code must be compiled using LF95’s-ml targetswitch in order to be callable by lan-
guagetarget(see”-ML target” on page 28).

Note thatDLL_EXPORTandDLL_IMPORTare statements and not attributes. In other word
DLL_EXPORTmay not appear in an attribute list in an INTEGER, REAL, COMPLEX, LOG
ICAL, CHARACTERor TYPE statement.

Table 7: -ML Switch Options

Switch Compiler

-ML LF95 Lahey/Fujitsu Fortran 95

-ML LF90 Lahey Fortran 90

-ML MSVC Microsoft Visual C++

-ML MSVB Microsoft Visual Basic

-ML BC Borland C++

-ML BD Borland Delphi

-ML WINAPI Windows API functions invoked directly from Fortran
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Calling DLLs from Fortran
When you create a Fortran routine that references a procedure in a DLL you declare the
procedure name with theDLL_IMPORTstatement in your Fortran code. The syntax of the
DLL_IMPORTstatement is:

DLL_IMPORT dll-import-name-list

Wheredll-import-name-listis a comma-separated list of names of DLL procedures refer-
enced in this scoping unit. The procedures may be subroutines or functions. Non-Fortr
DLL routines may only return default INTEGER, REAL, or LOGICAL results.

Use theDLL_IMPORTstatement as follows:

program main

implicit none

real :: My_Dll_Routine, x

dll_import My_Dll_Routine !name is case-sensitive.

x = My_Dll_Routine()

write (*,*) x

end program main

For further examples, refer to the directories below LF95’sEXAMPLESdirectory.

Passing Data
The only ways to pass data to or from a DLL are as arguments, function results, or in fi
LF95 does not support the sharing of data (as with a COMMON block) across the bound
of a DLL.

Delivering Applications with LF95 DLLs
When you deliver applications built with LF95 DLLs, you must deliver the DLLs you creat
and any required by the GUI front-end generating tool. All of the DLLs must be availab
on the path or in a directory that Windows checks for DLLs.

Fortran Calling Fortran DLLs
To create a DLL that works with a Fortran main program, indicate the exported procedu
with theDLL_EXPORTstatement, then run LF95 like this:

LF95 source.f90 -win -dll -ml LF95

The LF95 compiler builds the DLLsource.dll . It also builds asource.imp file contain-
ing the linker commands needed to link to this DLL. Note that the compiler allows you t
build your DLL from multiple.OBJ files. Remember that the-DLL switch is needed on any
file that contains aDLL_EXPORTstatement even if compiled with the-C option.
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Next build the Fortran Main with:

LF95 main.f90 -win -ml LF95 source.imp

Ensure that the DLL is available on your path.

C Calling Fortran DLLs
To use Fortran DLLs with Microsoft Visual C++, indicate in the Fortran source the proc
dures that you want to make available with theDLL_EXPORTstatements. Remember that the
source for the DLL must not have a main program. Then run the LF95 compiler as follo

LF95 source.f90 -win -ml msvc -dll

To compile your Fortran source for use with Borland C++, type this:

LF95 source.f90 -win -ml bc -dll

When LF95 creates a DLL to be called by C, it also creates an import library. Import libra
tell a linker what is available from a DLL. LF95 uses the Microsoft programLIB to build an
import library for Visual C++. It uses Borland’sIMPLIB to build the import library for Bor-
land C++. Once you’ve created the DLL, just link the associated import library
(source.lib in the above cases) with your C object code, and be sure the DLL is availa
on your system path.

Fortran Calling C DLLs
Before running the LF95 compiler, you must first build your DLL. Refer to your C manu
for specifics. The C compiler builds a.LIB file for the DLL.

To compile your Fortran source that calls a Microsoft Visual C++ DLL, type:

LF95 source.f90 -win -ml msvc -lib dll_src.lib

To compile your Fortran source that calls a Borland C++ DLL, type:

LF95 source.f90 -win -ml bc -lib dll_src.lib

Wheredll_src.lib is the name of the import library. Passing arguments from Fortran to
C DLL is done in the same way as for calling the Windows API. For more information, s
”Calling the Windows API” on page 48.

Referencing DLL Procedures
Fortran functions are called from C as functions returning a value.

For example, this Fortran function:
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integer function foo(i,j)

integer :: i, j

:

:

end function foo

uses this C prototype:

long foo(long int *i, long int *j);

To reference the above function from your C code, declare it with__stdcall :

long __stdcall foo(long int *i, long int *j);

In C++, use:

extern "C" {long __stdcall foo(long int *i, long int *j); };

For a short example, seemkvcf90.bat in LF95’sMIX_LANG\MSVCdirectory(for Microsoft
Visual C++) ormkbcf90.bat (for Borland C++) in LF95’sMIX_LANG\BC directory.

Passing Arguments from C or C++

Subroutines and default INTEGER, REAL, and LOGICAL function types are supported

Lahey’s calling conventions are as follows:

• All arguments are pass-by-address, not pass-by-value as in C.

• Arrays of pointers cannot be passed.

• COMPLEX and derived type arguments can be passed as pointers to structures. Fo
COMPLEX, these structures are:

typedef struct {

float real;

float imaginary;

} complex;

typedef struct {

double real;

double imaginary;

} double_complex;

• Character arguments are passed as pointers to strings. When a Fortran program un
contains character dummy arguments with len=*, then any routine calling that pro-
gram unit must append to the end of the argument list the length of each of the
corresponding actual arguments. The lengths must be passed by value.

For example, the Fortran subroutine:
Lahey/Fujitsu Fortran 95 User’s Guide 43



Chapter 2 Developing with LF95

lti-
y.
ill

that in
st
row
re

sion
alue
n

t you
array.

ok
subroutine example3 (int1, char1, int2, char2, char1_len)
integer int1, int2, char1_len
character (len=char1_len) :: char1
character (len=25) :: char2

end

would have this prototype in C:

void example3 (long int *int1, \
char *char1, \
long int *int2, \
char *char2, \
long int char1_len);

Passing Arrays in C or C++
Because C processes arrays as an array of arrays and Fortran processes arrays as mu
dimensional arrays, there are some special considerations in processing a Fortran arra
Excluding a single-dimension array (which is stored the same in C as in Fortran), you w
need to reverse the indices when accessing a Fortran array in C. The reason for this is
C, the right-most index varies most quickly and in Fortran the left-most index varies mo
quickly (multi-dimensional). In an array of arrays, the columns are stored sequentially:
1-column 1 is followed by row 1-column 2, etc. In a multi-dimensional array, the rows a
stored sequentially: row 1-column 1 is followed by row 2-column 1, etc.

Also note that all C arrays start at 0. We do not recommend that you use a lower dimen
bound other than zero (0) as your C code will have to modify the indices based on the v
used. We strongly recommend that you do not use negative lower and upper dimensio
bounds!

If the subscript ranges are not known at compile time, they can be passed at runtime, bu
will have to provide the code to scale the indices to access the proper members of the

Some sample code may help explain the array differences. Your Fortran code would lo
like:
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subroutine test(real_array)
real :: real_array(0:4,0:5,0:6,0:7,0:8,0:9,0:10)
integer :: i,j,k,l,m,n,o
do o = 0, 10

do n = 0, 9
do m = 0, 8

do l = 0, 7
do k = 0, 6

do j = 0, 5
do i = 0, 4

real_array(i,j,k,l,m,n,o) = 12.00
end do

end do
end do

end do
end do

end do
end do
end subroutine test

The equivalent C code would look like:

void test(float real_array[10][9][8][7][6][5][4])
int i,j,k,l,m,n,o;
/*
** this is what the subscripts would look like on the C side
*/
for(o = 0 ; o < 11; o++)

for(n = 0; n < 10; n++)
for(m = 0 ; m < 9; m++)

for(l = 0; l < 8; l++)
for(k = 0; k < 7; k++)

for(j = 0; j < 6; j++)
for(i = 0 ; i < 5; i++)

real_array[o][n][m][l][k][j][i] = 12.000;
return;

}

On the Fortran side of the call, the array argument must not be dimensioned as an ass
shape array. You should use explicit shape, assumed size, or adjustable arrays.

Microsoft Visual Basic Information
To create a DLL that will work with Microsoft Visual Basic, take Fortran source (without
main program) and indicate the procedures that you want available in the DLL with the
DLL_EXPORTstatement, then invoke the LF95 driver like this:

LF95 source.f90 -win -dll -ml msvb
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Declaring your Procedure in Visual Basic

In your BASIC code, a procedure’s declaration will be like one of the following example

Private Declare Function my_func Lib "my_dll" (ByRef my_arg As
Long) As Long

Private Declare Sub my_sub Lib "my_dll" (ByRef my_arg As Long)

(see the relevant section below if an item on the argument list is either an array or is char
datatype). Note that in the example above, “my_dll ” must specify a complete path in order
to operate within the Visual Basic Environment.

Passing Character Data in Visual Basic

Character arguments are passed as strings with the length of each string appended at t
of the argument list.

Character (string) arguments and hidden length arguments must be passed by value, i
declare the procedure’s arguments (actual and hidden) with theByVal keyword. Refer to the
exampleVBDEMOprogram. The following restrictions apply:

• Character arguments should be declared asCHARACTER(LEN=*).

• Fortran functions returning character data to Visual Basic are not supported.

Passing Arrays in Visual Basic

When passing an array from Microsoft Visual Basic you will need to declare the argum
as a scalar value in the Basic declaration, and pass the first element of the array as the
argument. Declare the array dummy argument normally in the Fortran procedure. Note
the default lower bound for arrays in Visual Basic is0, so you may find it helpful to explicitly
declare your Fortran arrays with a lower bound of0 for each dimension, or explicitly declare
your Basic arrays to have a lower bound of1 (this can be done at the module or procedure
level via theOption Base statement). Note also that arrays of strings cannot be passed f
Visual Basic to LF95.

Running the Visual Basic Demo

1. Compile theVBDEMO.F90file, located in LF95’sMIX_LANG\MSVBdirectory, using
the-dll -win -ml msvb switches.

2. Ensure that the resultingVBDEMO.DLLresides in a directory that is on your path.
Failure to do this will generally result in an “Error loading DLL” message from the
operating system.

3. Start Visual Basic and open theVBDEMO.VBPproject in LF95’sMIX_LANG\MSVB

directory.

4. Run the demo (F5).
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Passing Character Data in Delphi
Character arguments are passed as strings with the length of each string appended at t
of the argument list.

Delphi has two kinds of strings: long strings and short strings, where a long string can con
a very large number of characters and its length varies dynamically as needed, and a s
string has a specified length and may contain up to 255 characters. If your character a
ment is a short string you should use thevar keyword in your procedure’s declaration; omit
thevar keyword if your argument is a long string. Refer to theBDDEMOandBDDEMO2pro-
grams to see examples for both of these cases.

As of this writing, the following conditions apply:

• Character arguments should be declared asCHARACTER(LEN=*).

• “Long string” character arguments should be treated asINTENT(IN) .

• “Short string” character arguments may be treated asINTENT(IN OUT) .

• Fortran functions returning CHARACTER data to Delphi are not supported.

Passing Arrays in Delphi
Because Delphi processes multi-dimensional arrays as an array of arrays (like C and C
and Fortran processes arrays as multi-dimensional arrays, there are some special con
ations in processing a Fortran array. Refer to the “Passing Arrays in C or C++” section
more information.

Delphi Calling Fortran
To create a DLL that will work with Borland Delphi, take the Fortran source (without a ma
program) and indicate the procedures that you want available in the DLL with the
DLL_EXPORTstatement, then invoke the LF95 driver like this:

LF95 source.f90 -win -dll -ml bd

Declaring your Procedure in Delphi
In your Delphi code, a procedure’s declaration will be like one of the following example

function my_LF95_function(var my_arg: LongInt) : LongInt;
stdcall; external ‘my_dll.dll’;

procedure my_LF95_subroutine( var my_arg: Single); stdcall;
external ‘my_dll.dll’;

(see the relevant section below if an item on the argument list is either an array or is char
datatype).

Running the Delphi Calling Fortran Demo
1. Compile theBDDEMO2.F90file located in LF95’sMIX_LANG\BDdirectory using the

-dll , -win , and-ml bd switches.
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2. Ensure that the resultingBDDEMO2.DLLresides in a directory that is on your path.
Failure to do this will generally result in an “Debugger Kernel Error” message from
the operating system.

3. Start Delphi and open theBDDEMO2.DPRproject in LF95’sMIX_LANG\BDdirectory.

4. Run the demo (F9).

Fortran Calling Delphi DLLs
Before running the LF95 compiler, you must first build your DLL. Refer to your Delphi
manual for the specifics. Because Delphi does not build a.LIB file for the DLL, you will
need to specify the imported names on the command line.

To compile a Fortran routine to call a Delphi DLL:

LF95 main.f90 -win -ml bd -implib my_dll.dll -import func1

func2 ...

wheremain.f90 is the fortran program which callsfunc1 andfunc2 in my_dll.dll .

Running the Fortran Calling Delphi Demo

1. From Delphi, openF90CALBD.DPRin LF95’s MIX_LANG\BD directory.

2. Build the DLL by pressingCtrl-F9 .

3. CopyF90CALBD.DLL to LF95’sMIX_LANG\BD directory.

4. Change to LF95’sMIX_LANG\BD directory.

5. Run the compiler as follows:

LF95 f90calbd.f90 -win -ml bd -implib f90calbd.dll -import

bd_min bd_max

6. Run the resulting executable,F90CALBD.EXE

Examples
Please refer to the examples in the directories below LF95’sEXAMPLESdirectory for further
information on using the Fortran DLL interface.

Calling the Windows API
See the fileREAD_API.TXT for information on making direct calls to the Windows API.
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Static Linking
Linking statically gives a single executable file that contains all of the executable code
static data in the program. LF95 can link statically with code produced with Microsoft Vis
C/C++ or Borland C/C++. Information on static linking is the same as for dynamic linkin
(described above) with the following exceptions:

1. First make sure your LIB environment variable points to your C library directory.

2. Specify the-staticlink and-ml switches on the LF95 command line (do not
specify-dll ).

3. UseML_EXTERNALinstead ofDLL_IMPORTor DLL_EXPORTin your Fortran source.

4. You must have a Fortran main program.

5. Unlike with DLLs, Fortran common blocks can be accessed from within a statically
linked C routine. See the fileFTOC.BAT for more information.

6. Import libraries and.imp files do not need to be included on the LF95 command line
(import libraries and.imp files are specific to DLLs).

7. Fortran common blocks can be accessed from C when the C is statically linked (this
is not possible with a DLL). If you have a common block calledcommon_nameor
COMMON_NAME, access it in C as a structure variable calledcommon_name_(note
the trailing underscore). For example, reference:

common /my_common/ a, b, c

real a, b, c

as:

extern struct

{

float a, b, c;

} my_common_; /* my_common must be all lower case */

Fortran common blocks are aligned on one-byte boundaries. To align your C struc-
tures along one-byte boundaries, use the/Zp1 switch or thepack pragma with
Microsoft Visual C++. Use the-a- switch or theoption -a- pragma with Borland
C++. Note that use of these switches should be limited to files or sections of code
that require one-byte alignment; one-byte alignment can cause slower access to C
structure members.

For more information, see the examples in LF95’sEXAMPLES\MIX_LANG\MSVCandEXAM-

PLES\MIX_LANG\BC directories.
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OpenGL Graphics Programs
OpenGL is a software interface for applications to generate interactive 2D and 3D comp
graphics independent of operating system and hardware operations. It is essentially a 2
graphics library which was originally developed by Silicon Graphics with the goal of creat
an efficient, platform-independent interface for graphical applications (Note: OpenGL is
trademark of Silicon Graphics Inc.). It is available on many Win32 and Unix systems, an
strong on 3D visualization and animation.

f90gl is a public domain implementation of the official Fortran 90 bindings for OpenGL, c
sisting of a set of libraries and modules that define the function interfaces. The library,
module files, demonstration programs, and documentation are documented in the file
readf9gl.txt . The f90gl interface was developed by William F. Mitchell of the Mathema
ical and Computational Sciences Division, National Institute of Standards and Technol
Gaithersburg, in the USA. For information on f90gl, see the F90GL web page at http://
math.nist.gov/f90gl.

Until recently, the OpenGL LF9x applications could only be built as statically linked app
cations targeted for Visual C. A much friendlier method is now available thanks to a por
effort implemented by Lawson B. Wakefield of Interactive Software Services Ltd. in the U
(ISS are the developers of the INTERACTER & Winteracter GUI/graphics Fortran deve
ment tools). This implementation has made the OpenGL interface available within the
framework of the WISK and Winteracter libraries. A full set of examples is available un
the WISK directory of the LF95 installation.

Recommended Switch Settings
Inspect theLF95.FIG file to determine current switch settings.

For debugging, we recommend the following switch settings:

-chk (a,e,s,u,x) -chkglobal -g -pca -stchk -trace -w -info

(Note: Specifying-chkglobal or -chk (x) must be used for compilation of all files of the
program, or incorrect results may occur.)

For further analysis during development, and consider specifying any of following switc
settings:

-ap -co -cover -f95 -info -lst -wo -xref

For production code, we recommend the following switch settings:

-nap -nchk -nchkglobal -ncover -ng -o1 -npca -nsav -nstchk
-ntrace

Use-t4 , -tp, or -tpp depending on your preferred target processor.
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Lahey ED for Windows (ED) is a Fortran-smart development environment. You can ed
compile, link, and run your programs all from within ED. ED offers sophisticated editin
features like syntax highlighting, intelligent procedure browsing, code completion, mac
drag and drop, as well as the standard editing features you are accustomed to. After a
pilation, ED highlights the exact location of programming errors diagnosed by the compi

You can also debug Windows programs with ED. While debugging, you can watch the
ues of variables change during program execution and set breakpoints with a mouse c

This chapter assumes a basic familiarity with Windows. It presents an overview of ED’
functionality. For detailed information, please see ED’s on-line help.

Setting Up and Starting ED

Startup
ED must be run from Windows. Start ED by double-clicking the Lahey ED for Windows
icon.
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Exiting ED
To exit from ED, chooseFile|Exit from the menu, double-click the system menu icon i
the top left corner, or pressAlt-F4.

Always exit ED before turning off your computer. ED checks for unsaved changes and
enables you to save these before exiting.

The ED Screen

The Menu Bar
ED features pull-down menus from which the various ED commands can be invoked.
open a menu, click on item on the menu bar with the mouse or pressAlt- underlined letter.
Select a command by clicking on it with the mouse or by pressingunderlined letter.

Docked Toolbar

Floating Toolbar

Menu Bar

Status Bar

Window Tabs

Toolbar Buttons

Current Window
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The Status Bar
The status bar displays information about the current state of ED. It is more than inform
tional. Click on:

• Insert/Overtype/View to toggle Insert/Overtype/View mode.

• the Word Wrap Status to toggle word wrap on or off.

• the Macro Status to play the current macro.

• the Time and Date to change the time and date format.

• the Cursor Line and Column to go to a particular line and column.

• Edited to save the current file.

• the Filename to change the active window.

• Select Toolbar to select or deselect toolbars.

The Text Bar
ED’s Text Bar provides a visual reminder of lines that have been edited and lines that h
been added. When debugging (see”Debugging” on page 61), the Text Bar marks the cur
rent line and lines with breakpoints. You can activate the Text Bar by right-clicking on wh
space to the left of any line, or by selectingOptions|Configuration|Display and
checking theText Bar Visible box.

Toolbars
Toolbars provide a quick way to issue commands with the mouse. ED comes with a va
of toolbars. Display different toolbars by pressing the Select Toolbar button on the status

Point to a toolbar button to pop up quick help on that button. To issue the command, le
click.

Edited Line

Breakpoint

Insert/Overtype
View Mode

Word
Wrap

Macro
Status Time and Date Cursor Line and Column

Edited?

Filename

Window
Number Select

Toolbar

New Line

Current Line
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ED’s window bar makes switching between open files easy. Left-click on a window tab
make that window current. Right click on a tab to perform other operations on that file.

Getting Help
Get general help on ED by pressingF1. Get context-sensitive help by pressingShift-F1 .
Both general and context-sensitive help are also available through the Help menu. A q
tour of ED is available throughHelp|Help Contents . This is especially valuable if you
are new to ED and would like to get a glimpse of the features it offers. You can also vie
quick reference to ED’s shortcut keys by pressingAlt-Q or by selectingHelp|Quick

Reference .

Managing Files

Creating A File From Scratch
To create a new file, selectFile|New . Select a file type (file extension). You now have an
empty file you can edit. Save the file by selectingFile|Save or by clicking on theSave

file button on the docked toolbar. You can also create a new file by clicking on theOpen

File for Editing button on the docked toolbar. TheFile|Open dialog box appears.
Select a drive and directory and enter a name for the file. Click OK to create the file.
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Opening A File
Opening a file that already exists is also done usingFile|Open . You can choose to select
directories and files either from a list of those that exist or from a history of those most
recently used.

Files are opened in edit mode by default. To open a file in view-only mode, select
File|View . Toggle between edit and view modes by pressingAlt-F3 .

If you use include files, you can view them by right clicking on the filename in the INCLUD
line in your code.
Lahey/Fujitsu Fortran 95 User’s Guide 55



Chapter 3 Editing and Debugging with ED

with
col-
ew

for

he

tion/
Syntax Highlighting
ED highlights Fortran syntax elements, like keywords, literal constants, and comments,
different colors. This facility can be customized in several ways. To change the default
ors, select Options|Color Setup. To change the elements that ED highlights or to add n
elements of your own, edit the filelang_for.iii , whereiii are your initials.

By default, only files that end in.for , .f90 , and.f use Fortran syntax highlighting. Other
file extensions are set to use no syntax highlighting. You can turn on syntax highlighting
some 30 other languages by selectingOptions|File Extension Setup . Only files setup
with Fortran syntax highlighting or with no syntax highlighting can be saved, however.

Navigation
After you have opened a file, move through it using:

• the normal keyboard navigation keys (PageUp, PageDown, Home, End, etc.)

• the mouse on the scroll bar

• Goto|... to jump to a particular kind of location. TheGoto menu lists many loca-
tions to jump to, most with quick keyboard equivalents.

Previous/Next Procedure
You can quickly move though your file by jumping from procedure to procedure using t
Ctrl-PageUp andCtrl-PageDown keys.

Function/Procedure List
ED will create a list of procedures in your file if you:

• ChooseGoto|Function List;

• PressAlt-F1; or

• Click the Function/procedure list button on the toolbar

You can then jump directly to any procedure by double clicking on its name in the Func
procedure list.
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Find
The Search menu provides a variety of ways to find and optionally replace text. You ca
search for exact text or use regular expressions, where wildcard characters (* and?) can be
inserted in your search string. You can also search incrementally.Incremental search

finds the next occurrence of text as you type it.

Matching Parentheses and Statements
You can move automatically to a matching object (a parenthesis or statement) by right c
ing on an object. For example, in an expression, right-clicking on a parenthesis will jum
the matching parenthesis. This is a real time-saver in putting together complicated error
expressions. Right-clicking on a DO statement jumps to the corresponding END DO s
ment. Right-clicking on an IF statement jumps in succession to any ELSE or ELSE IF
statements and ultimately to the corresponding END IF statement.

Editing
To toggle between edit and view modes use theAlt-F3 key. When in view mode the file is
protected from changes and is not locked, permitting other people to view the file at the s
time.

Undo and Redo
You can undo any editing or cursor movement in ED. To undo the previous operation, s
Edit|Undo or pressCtrl-Z . To redo the last operation you have undone, select
Edit|Redo or pressCtrl-Y .

Extended Characters
To type characters outside the range of your keyboard:

• Be sure the NumLock key is on.

• TypeAlt-0 ANSI character codeto enter Microsoft Windows ANSI font characters
above 127.

• TypeAlt- OEM character codeto enter DOS extended characters above 127.

• To enter characters below 32 such as^A, ^B, ^C, etc., select Edit|Verbatim Character,
then type the character. This prevents the control key sequence from being inter-
preted as an ED command.
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Blocks
A block is an area of marked text. Once marked, a block can be deleted, moved, copie
searched, sorted, or printed.

Block Operations

ED recognizes three kinds of blocks: stream, line, and column:

• Stream blocksare the usual Windows marked blocks. They begin and end at any
locations you choose and include all characters in-between.

• Line blocksmark whole lines.

• Column blocksmark a rectangular area.

Marking a Block with the Keyboard

Position the cursor at the start of the block. SelectBlock and thenStream Block , Line

Block , orColumn Block . Expand the block using the arrow keys,PageUp, andPageDown.

Marking a Block with the Mouse

Simply click and drag to mark a block with the mouse. To toggle between the three diffe
kinds of blocks, click the right mouse button while still holding down the left mouse butt

Marking a Word or Line

To mark a word, double-click on the word. Double click in white space left or right of a li
to mark the whole line.

Drag and Drop

You can move a marked block to a new location by clicking on the marked block, holdi
the mouse button down while you move the block, then releasing the mouse button at
desired location. You can copy rather than move a block by holding down the control k
while you drag and drop.

Coding Shortcuts
Words or constructs that you type repeatedly can be entered automatically or finished fo
by ED.

Templates
Templates are abbreviations for longer sequences of characters. These sequences can
or a few words or can comprise several lines. ChooseOptions|Language Words & Tem-

plates then pressCtrl-PageDown to view the Fortran templates. When ED is installed
file called lang_for.iii (whereiii are your initials) is set up. To modify existing tem-
plates or add new ones, edit this file.
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Templates are expanded by pressingEsc or Space after typing a template abbreviation. You
can specify the number of characters beforeEsc or Space will cause template expansion by
selectingOptions|File Extension Setup|Templates & Word Wrap .

Smartype
Smartype recognizes words you have already typed in your file. If you type the first few
characters of a word that appears earlier in the file, then press Esc or Space, the word w
automatically completed for you. If there is an ambiguity you will be presented with a me
of words to select from.

Smartype can be deactivated for the Space key by turning offSpace does Smartype in
Options|File Extension Setup|Templates & Word Wrap .

Case Conversion
Case conversion changes the case of words you type to match instances of words ear
the file or to match words in thelang_for.iii file. In this way ED ensures consistency in
capitalization.

Case conversion can be toggled off or on inOption|File Extension Setup .

Code Completion
Code completion finishes open nesting levels introduced by keywords or parentheses.
completion is activated with theEsc key. For example, if you’ve typed:

a = b * ( c + ( d - e

pressing Esc once will give

a = b * ( c + ( d - e )

and pressing Esc again will give

a = b * ( c + ( d - e ) )
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Compiling Your Program
There are two ways of compiling your program while in ED. You can click on the Lahey
LF95 button from the toolbar, or selectTools|Programs|Lahey/Fujitsu LF95|Run .
When you do so, a window will appear that captures the compiler’s output and shows t
compiler’s progress through your source file. Pressing theF4 key will tile the source and
compile windows.

Alternately, you can select the DOS button and compile as described in”Developing with
LF95” on page 11. Redirecting the compiler’s output to theerrs.iii file (whereiii

are your initials) will enable you automatically to locate errors in your source, as descri
below.

Locating Errors
ED automatically synchronizes your program source with errors detected by the compi
To browse through errors, chooseGoto|Next Error or Goto|Previous Error , click on
the next or previous error button on the toolbar, or pressAlt-UpArrow orAlt-DownArrow .
ED automatically moves the cursor to the appropriate location in your source file.
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Changing Compiler Options
To change the LF95 compile line used by ED, select Tool|Programs, then select the 'Ge
radio button, then select Lahey/Fujitsu LF95|Edit. The following variables may be used
theCommand Line andWorking Directory fields.

Debugging
Lahey ED for Windows’ integrated debugger can run your program, set breakpoints, st
line at a time, view the values of variables in your program in several different ways, an
change the values of variables while running your program. The current executable line
any breakpoints are indicated with markers in the Text Bar (see”The Text Bar” on page 53).

Table 8: Command Line Variables

Variable Evaluates to

<NAME> Name of the current file including drive and path.

<PATH> Drive and path for the current file.

<FILE>
Filename of current file without drive\path and file
extension.

<EXT> Filename extension.

<CWD> Current working directory.

<ED_DIR> ED executable’s directory.

<ENTER> Prompts the user for a filename.

<1> User’s response from first<ENTER>.

<2> User’s response from second<ENTER>.

<3> User’s response from third<ENTER>.

<DATE> Current system date.

<INITIALS> Your initials.

<WORD> The word at the current cursor position.
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Starting the Debugger
Note that with version 5.5 of LF95, the Lahey/ED debugging facility is off by default and
replaced by WinFDB. However, you can still use the Lahey/ED debugger by selecting
SOLD95 Toolbar from within ED using Options|Toolbars.

Before debugging your program you must compile it using the-g and-winconsole or
-win switches (see“Changing Compiler Options”, above, and”Compiler and Linker
Switches”on page 17). The-g switch creates an additional file with debugging information
This file ends with the extension .ydg . The-win or -winconsole switch creates a Win-
dows executable file. Start debugging by clicking on theDebug Program button in the
Lahey Fortran toolbar, or by selectingTool|Debug . Note that Lahey ED can be used to
debug both LF95 and LF90 programs. If you will use LF95’s Lahey ED to debug LF90 e
cutables, you must first delete any .ydg files that exist for these executables in the sam
directory.

It is most convenient always to have the Lahey Fortran toolbar visible while debugging
When prompted, enter the name of the executable file, including the filename extensio
(.exe ) and, if the file is not in ED’s current directory, a path. For example, if the executa
file myprog.exe is in a directory called “programs ” below the root, you would enter

\programs\myprog.exe

ED will expand the Text Bar and put the current line icon next to the first executable line
your program. It will also open the SOLD95W Output Window so that you can view actio
performed by the debugger. Once your program is loaded, click on theDebug Program but-
ton again to bring up the debug menu. You can also bring up the debug menu by selec
Tool|Debug or by right-clicking in ED’s Text Bar.
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Running Your Program
To run your program, selectRun Program from the debug menu, press theF6 key, or click
on theRun Program button. Just running your program is not particularly useful. You wi
want your program to stop occasionally by setting breakpoints or by running a line at a ti
In this way you can inspect or change the values of variables at troublesome locations in
program.

To run to a particular line in your program, click on that line, then selectRun to Current

Line from the debug menu.

Running a Line at a Time
To execute the current executable line in your program (marked with the current line ma
in the Text Bar), click on either thestep Into or Step Over button, or selectStep Into

or Step Over from the debug menu. If the current line is a subprogram invocation,Step

Into will execute the current line and move the current line marker to the first executab
line in the subprogram;Step Over will execute the entire invoked subprogram and move
the current line marker to the next executable line in the current subprogram.

Setting Breakpoints
Often when debugging you will want to have your program stop at a particular location
your source code, or when a particular condition occurs. Such a stopping place is calle
breakpoint. To set a breakpoint, click on theCheckpoints button, or selectCheckpoints

from the debug menu. The following dialog box displays:
Lahey/Fujitsu Fortran 95 User’s Guide 63



Chapter 3 Editing and Debugging with ED
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To set a breakpoint on entry to a particular program unit, click on theOn Program Unit

Entry checkbox, select the program unit from the list of program units, then click onSet

Breakpoint . The breakpoint will display in theCheckpoints list. You can remove a
breakpoint by highlighting it in the list and clickingRemove.

To set a breakpoint on a particular line, first click on that line in your source, open the Ch
points dialog and click theAt Line: checkbox. Then click onSet Breakpoint . A
shortcut for this procedure is to simply left-click in the Text Bar next to the desired line.

To set a breakpoint on a particular condition, click theIf: checkbox. You can set break-
points based on whether a condition holds true, such as ifa is greater than100 , or based on
when a value changes.

You can remove all breakpoints at once by clicking on theRemove All button in the Check-
points dialog.
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Displaying the Values of Variables
Values of variables can be displayed three different ways. To display the value of a sc
variable of an intrinsic type (REAL, COMPLEX, INTEGER, LOGICAL, or CHARACTER,
as opposed to a derived type), simply right click on the variable name. A box will appe
with the name of the variable and its value.

To display the value of any variable, including derived types and arrays and combinatio
thereof, click on theDisplay Variable button or selectDisplay Variable from the
debug menu. Select the variable from the list of variables provided. The name and valu
the variable appear in the SOLD95W Output Window.

To watch values of variables change as you step through your code, open the Watches D
by clicking on theOpen Watches Dialog button or by selectingOpen Watches Dialog

from the debug menu. A Dialog like the following displays:

In the above Watch Dialog,GAME_BOARDis an array. To expand the values of all element
in the array, click on the ‘+’ next toGAME_BOARD. Click on ‘- ’ to collapse it again. This will
work for variables of derived type as well. The Watch Dialog can be resized by dragging
edges or corners with the mouse.

It is recommended that large arrays be kept collapsed while stepping through your prog
as updating the values of the elements of large arrays while stepping is time consumin
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Changing the Values of Variables
You can change the value of a variable in a Watch Dialog (see above) by clicking on it,
changing its value in the space below and clickingChange. Only scalar data, single elements
of arrays, and single components of derived types can be changed in this way.

Reloading your Program
To reload your program, selectReload Program from the debug menu. All checkpoints
will remain in effect.

Configuration
To change ED’s configuration selectOptions|Configuration or pressF11. Click on the
appropriate tab to display and change a configurable item. Pressing the help button wh
one of the configuration dialog boxes brings up context-sensitive help on any of the feat
in the dialog box.

Status Line

Controls display of the time, date, and window bar.

Display

Controls the display of windows, control characters, menus, and toolbars.

Fonts

Controls the type and size of the display font.

Colors

Controls the colors for syntax highlighting of your source.

Session Info

Controls various parameters for the way ED starts, including whether to restore the cur
directory, whether to save the desktop state automatically on exit, how large a cache to
and how large a history list to keep.

Behavior

Controls keyboard emulation, cursor movement and insert/replace behavior.

Safety

Controls how backup copies of your source file are kept.

Locking

Controls how files are locked when accessed on a LAN.
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FDB is a command-line symbolic source-level debugger for Fortran 95, C, and assembly
grams. Use FDB if you feel more comfortable with a command-line debugger than with
WinFDB Windows debugger, or if you need access to debugging commands not availab
WinFDB.

Before debugging your program you must compile it using the-g switch (see”Compiler and
Linker Switches”on page 13). The-g switch creates an additional file with debugging infor
mation -- this file has the same name as the executable with the extension .ydg . Debugging
cannot be performed without the presence of the .ydg file in the same directory as the e
cutable file. FDB cannot be used on LF90 executables.

Starting FDB
To start FDB type:

FDB exefile

Where: exefileis the name of an executable file compiled with the-g option.

Commands
Commands can be abbreviated by entering only the underlined letter or letters in the co
mand descriptions. For example,kill can be abbreviated simplyk andoncebreak can be
abbreviatedob. All commands should be typed in lower case, unless otherwise noted.
Lahey/Fujitsu Fortran 95 User’s Guide 67



Chapter 4 Command-Line Debugging with FDB
Executing and Terminating a Program

run arglist

Passes thearglist list of arguments to the program at execution time. Whenarglist is omitted,
the program is executed using the arguments last specified. Ifarglist contains an argument
that starts with "<" or ">", the program is executed after the I/O is redirected.

Run

Executes the program without arguments. The “R” should be upper case.

kill

Forces cancellation of the program.

param commandline arglist

Assign the program’s command line argument list a new set of values

param commandline

Display the current list of command line arguments

clear commandline

The argument list is deleted

quit

Ends the debugging session.

Shell Commands

cd dir

Change working directory todir

pwd

Display the current working directory path
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Breakpoints

General Syntax
break [location[? expr]]

Wherelocationcorresponds to an address in the program or a line number in a source f
andexprcorresponds to a conditional expression associated with the breakpoint. The v
of locationmay be specified by one of the following items:

• [’ file’ ] line specifies line numberline in the source filefile. If omitted,file defaults
to the current file.

• proc [+ |- offset] specifies the line number corresponding to the entry point of func-
tion or subroutineproc plus or minusoffsetlines.

• [mod@]proc[@inproc] specifies function or subroutineproc in current scoping unit,
or internal procedureinproc within proc,or procedureproc contained in module
mod.

• *addr specifies a physical address (default radix is hexadecimal).
• If location is omitted, it defaults to the current line of code

The conditional expressionexprcan be constructed of program variables, typedef elemen
and constants, along with the following operators:

Minus unary operator (-)
Plus unary operator (+)
Assignment statement (=)
Scalar relational operator (<, <=, ==, /=, >, >=, .LT., .LE., .EQ., .NE., .GT., .GE.)
Logical operator (.NOT., .AND., .OR., .EQV., .NEQV.)

break [ ’ file ’ ] line
Sets a breakpoint at the line numberline in the source filefile. If omitted,file defaults to the
current file. Note that the “apostrophes” in ‘file‘, above, are the standard apostrophe ch
ter (ascii 39).

break [ ’ file ’ ] funcname
Sets a breakpoint at the entry point of the functionfuncnamein the source filefile. If omitted,
file defaults to the current file. Note that the “apostrophes” in ‘file‘, above, are the stand
apostrophe character (ascii 39).

break *addr
Sets a breakpoint at addressaddr .

break
Sets a breakpoint at the current line.
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cond ition # n expr
Associate conditional exprestionexprwith the breakpoint whose serial number isn. Note that
the “#” symbol is required.

cond ition # n
Remove any condition associated with the breakpoint whose serial number is n. Note
the “#” symbol is required.

onceb reak
Sets a temporary breakpoint that is deleted after the program is stopped at the breakpo
once. OnceBreak in other regards, including arguments, works like Break.

regularb reak " regex "
Set a breakpoint at the beginning of all functions or procedures with a name matching re
expression regex.

delete location
Removes the breakpoint at locationlocationas described in above syntax description.

delete [ ’ file ’ ] line
Removes the breakpoint for the line numberline in the source file specified asfile. If omitted,
file defaults to the current file. Note that the “apostrophes” in ‘file‘, above, are the stand
apostrophe character (ascii 39).

delete [ ’ file ’ ] funcname
Removes the breakpoint for the entry point of the functionfuncname in the source filefile.
If omitted,file defaults to the current file. Note that the “apostrophes” in ‘file‘, above, are t
standard apostrophe character (ascii 39).

delete *addr
Removes the breakpoint for the addressaddr .

delete #n
Removes breakpoint numbern.

delete
Removes all breakpoints.

skip # n count
Skips the breakpoint numbern counttimes.
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Upon encountering breakpointn, execute the specified fdb command(s).

show break

B

Displays all breakpoints. If using the abbreviation “B”, the “B” must be upper case.

Controlling Program Execution

continue [ count ]

Continues program execution until a breakpoint's count reachescount. Then, execution stops.
If omitted, count defaults to 1 and the execution is interrupted at the next breakpoint. Prog
execution is continued without the program being notified of a signal, even if the progra
was broken by that signal. In this case, program execution is usually interrupted later w
the program is broken again at the same instruction.

silentc ontinue [ count ]

Same as Continue but if a signal breaks a program, the program is notified of that signal w
program execution is continued.

step [ count ]

Executes the nextcountlines, including the current line. If omitted,countdefaults to 1, and
only the current line is executed. If a function or subroutine call is encountered, execut
“steps into” that procedure.

silen tstep [ count ]

Same as Step but if a signal breaks a program, the program is notified of that signal wh
program execution is continued.

stepi [ count ]

Executes the nextcountmachine language instructions, including the current instruction.
omitted,countdefaults to 1, and only the current instruction is executed.

si lentstepi [ count ]

Same as Stepi but if a signal breaks a program, the program is notified of that signal w
program execution is continued.
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next [ count ]
Executes the nextcountlines, including the current line, where a function or subroutine ca
is considered to be a line. If omitted,countdefaults to 1, and only the current line is executed
In other words, if a function or subroutine call is encountered, execution “steps over” th
procedure.

silen tnext [ count ]
Same as Next but if a signal breaks a program, the program is notified of that signal wh
program execution is continued.

nexti [ count ]
Executes the nextcountmachine language instructions, including the current instruction,
where a function call is considered to be an instruction. If omitted,countdefaults to 1, and
only the current instruction is executed.

silentnexti [ count ] or nin [ count ]
Same as Nexti but if a signal breaks a program, the program is notified of that signal w
program execution is continued.

until
Continues program execution until reaching the next instruction or statement.

until loc
Continues program execution until reaching the location or lineloc.

until *addr
Continues program execution until reaching the addressaddr.

until +|- offset
Continues program execution until reaching the line forward (+) or backward (-)offsetlines
from the current line.

until r eturn
Continues program execution until returning to the calling line of the function that includ
the current breakpoint.

Displaying Program Stack Information

traceback [ n]
Displays subprogram entry points (frames) in the stack, wheren is the number of stack
frames to be processed from the current frame.
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frame [# n]
Select stack frame numbern. If n is omitted, the current stack frame is selected. Note tha
the “#” symbol is required.

upside [ n]
Select the stack frame for the procedure n levels up the call chain (down the chain if n is
than 0). The default value of n is 1.

down side [ n]
Select the stack frame for the procedure n levels down the call chain (up the chain if n is
than 0). The default value of n is 1.

show args
Display argument information for the procedure corresponding to the currently selected
frame

show locals
Display local variables for the procedure corresponding to the currently selected frame

show reg [ $ r ]
Displays the contents of the registerr in the current frame.r cannot be a floating-point reg-
ister. If $r is omitted, the contents of all registers except floating-point registers are display
Note that the $ symbol is required.

show freg [ $ fr ]
Displays the contents of the floating-point registerfr in the current frame. If $fr is omitted,
the contents of all floating-point registers are displayed. Note that the $ symbol is requ

show regs
Displays the contents of all registers including floating-point registers in the current fram

show map
Displays the address map.

Setting and Displaying Program Variables

set variable = value
Setsvariableto value.
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set *addr = value

Sets*addr to value.

set reg = value

Setsreg to value. reg must be a register or a floating-point register.

print [: F][ variable ]

Displays the content of the program variablevariableby using the edit formatF. If edit for-
matF is omitted, it is implied based on the type of variable.variablecan be a scalar, array,
array element, array section, derived type, or derived type element.F can have any of the fol-
lowing values:

x hexadecimal

d signed decimal

u unsigned decimal

o octal

f floating-point

c character

s character string

a address of variable (use “&variable ” to denote l-value)

memprint [: FuN ] addr

dump [:FuN ] addr

Displays the content of the memory addressaddr by using edit formatF. u indicates the dis-
play unit, andN indicates the number of units.F can have the same values as were define
for the Print command variableF.

If omitted, f defaults tox (hexadecimal).

u can have any of the following values:

b one byte

h two bytes (half word)

w four bytes (word)

l eight bytes (long word/double word)

If u is omitted, it defaults tow (word). If n is omitted, it defaults to 1. Therefore, the two fol
lowing commands have the same result:
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memprint addr
memprint :xw1 addr

Source File Display

show source
Displays the name of the current file.

list now
Displays the current line.

list [ next ]
Displays the next 10 lines, including the current line. The current line is changed to the
line displayed.

list prev ious
Displays the last 10 lines, except for the current line. The current line is changed to the
line displayed.

list around
Displays the last 5 lines and the next 5 lines, including the current line. The current line
changed to the last line displayed.

list [ ’ file ’ ] num
Changes from the current line of the current file to the line numbernumof the source filefile,
and displays the next 10 lines, including the new current line. Iffile is omitted, the current
file is not changed.

list +|- offset
Displays the line forward (+) or backward (-)offsetlines from the current line. The current
line is changed to the last line displayed.

list [ ’ file ’ ] top ,bot
Displays the source file lines between line numbertopand line numberbot in the source file
file. If file is omitted, it defaults to the current file. The current line is changed to the last l
displayed.

list [ func[tion ] funcname
Displays the last 5 lines and the next 5 lines of the entry point of the functionfuncname.
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disas
Displays the current machine language instruction in disassembled form.

disas *addr1 [ ,*addr2 ]
Displays the machine language instructions between addressaddr1and addressaddr2in dis-
assembled form. Ifaddr2is omitted, it defaults to the end of the current function that contai
addressaddr1.

disas funcname
Displays all instructions of the functionfuncnamein disassembled form.

Automatic Display

screen [: F] expr
Displays the value of expression expr according to format F every time the program sto

screen
Displays the names and values of all expressions set by the screen [:F] exprcommand above.

uns creen [#n]
Remove automatic display numbern (“#” symbol reqired). When #n is omitted, all are
removed.

screenof f [#n]
Deactivate automatic display numbern. When #n is omitted, all are deactivated.

screenon [# n]
Activate automatic display numbern. When #n is omitted, all are activated.

show screen
Displays a numbered list of all expressions set by the screen [:F] exprcommand above.

Symbols

show function [" regex "]
Display the type and name of all functions or subroutines with a name that matches reg
expressionregex. Whenregexis omitted, all procedure names and types are displayed.
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show variable [" regex "]
Display the type and name of all variables with a name that matches regular expressionregex.
Whenregexis omitted, all variable names and types are displayed.

Scripts

alias cmd "cmd-str "
Assigns the fdb command(s) incmd-strto aliascmd.

alias [ cmd ]
show alias [ cmd ]
display the aliascmddefinition. Whencmdis omitted, all the definitions are displayed.

unalias [cmd]
Remove the aliascmddefinition. Whencmdis omitted, all the definitions are removed.

Signals

signal sig action
Behavioractionis set for signalsig. Please refer to signal(5) for the name which can be sp
ified for sig. The possible values foractionare:

stopped Execution stopped when signal sig encountered
throw Execution not stopped when signal sig encountered

show signal [ sig ]
Displays the set response for signalsig. If sig is omitted, the response for all signals is
displayed.

Miscellaneous Controls

param listsize num
The number of lines displayed by thelist command is set tonum. The initial (default) value
of numis 10.

param prompt " str "
str is used as a prompt character string. The initial (default) value is “fdb* ”. Note that the
double quotes are required.
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param printelements num
Set the number of displayed array elements tonumwhen printing arrays. The initial (default)
value is 200. The minimum value ofnumis 10. Settingnumto 0 implies no limit.

param prm
Display the value of parameterprm.

Files

show exec
Display the name of the current executable file.

param execpath [ path ]
Add pathto the execution file search path. Ifpath is omitted, the value of the search path is
displayed. Note that this search path is comprised of a list of directories separated by
semicolons.

param srcpath [ path ]
Add pathto the source file search path when searching for procedures, variables, etc. Ifpath
is omitted, the value of the search path is displayed. Note that this search path is comp
of a list of directories separated by semicolons.

show source
Display the name of the current source file.

show sources
Display the names of all source files in the program.

Fortran 95 Specific

breakall mdl
Set a breakpoint in all Fortran procedures (including internal procedures) in modulemdl.

breakall func
Set a breakpoint in all internal procedures in procurefunc.

show ffile
Displays information about the files that are currently open in the Fortran program.
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show fopt

Display the runtime options specified at the start of Fortran program execution.

Communicating with fdb

Functions

In a Fortran 95 program, if modules and internal subprograms are used, functions are s
fied as the following:

A module subprogramsubdefined inside a modulemoduleis specified asmodule@sub.

An entry pointentdefined inside a modulemoduleis specified asmodule@ent.

An internal subprograminsubdefined inside a module subprogramsubwithin a modulemod-
ule is specified asmodule@sub@insub.

An internal subprograminsubdefined inside a subprogramsubis specified assub@insub.

The name of the top level function, MAIN_, is not needed when specifying a function.

Variables

Variables are specified infdb in the same manner as they are specified in Fortran 95 or C

In C, a structure member is specified asvariable. memberor variable-> memberif variable
is a pointer. In Fortran 95, a derived-type (i.e., structure) component is specified as
variable%member.

In C, an array element is specified asvariable[ member][ member] .... In Fortran 95, an array
element is specified asvariable( member, member, ...) . Note that in Fortran 95, omission of
array subscripts implies a reference to the entire array. Listing of array contents in For
95 is limited by theprintelements parameter (see”Miscellaneous Controls” on page
77).

Values

Numeric values can be of types integer, real, unsigned octal, or unsigned hexadecimal
ues of type real can have an exponent, for example3.14e10 .

In a Fortran 95 program, values of type complex, logical, and character are also allowed
ues of type complex are represented as (real-part,imaginary-part). Character data is
represented as "character string" (the string is delimited by quotation marks, i.e., ascii 34

Values of type logical are represented as.t. or .f. .
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Addresses
Addresses can be represented as unsigned decimal numbers, unsigned octal numbers
must start with 0), or unsigned hexadecimal numbers (which must start with0x or 0X). The
following examples show print commands with address specifications.

memprint 1024 (The content of the area addressed by0x0400 is displayed.)

memprint 01024 (The content of the area addressed by0x0214 is displayed.)

memprint 0x1024 (The content of the area addressed by0x1024 is displayed.)

Registers
$BP Base Pointer
$SP Stack Pointer
$EIP Program counter
$EFLAGS Processor state register
$ST[0-7] Floating-point registers

Names
In Fortran 95 programs, a lowercase letter in the name (such as a function name, varia
name, and so on) is the same as the corresponding uppercase letter. The main program
is MAIN_ and a subprogram name is generated by adding an underscore(_) after the corre-
sponding name specified in the Fortran source program. A common block name is also
generated by adding an underscore (_) after the corresponding name specified in the Fortra
source program.
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WinFDB is the Windows version of the FDB symbolic source-level debugger for Fortran
C, and assembly programs. While debugging, you can watch the values of variables ch
during program execution and set breakpoints with a mouse click. The WinFDB debug
can run your program, set breakpoints, step a line at a time, view the values of variable
your program in several different ways, and change the values of variables while runnin
your program. The current executable line and any breakpoints are indicated with mar
in the left margin of the source code display.

Before debugging your program you must compile it using the-g switch (see”Compiler and
Linker Switches”on page 17). The-g switch creates an additional file with debugging infor
mation -- this file has the same name as the executable with the extension .ydg . Debugging
cannot be performed without the presence of the .ydg file in the same directory as the e
cutable file. WinFDB cannot be used on LF90 executables.

This chapter assumes a basic familiarity with Windows. It presents an overview of Win
FDB’s functionality. More detailed information is available through WinFDB’s on-line he

How to Start and Terminate WinFDB
There are three ways to start the WinFDB debugger:

1. From the Windows command prompt

2. From the desktop icon or from the Start menu

3. From the Lahey ED developer

Starting from the command prompt
Type WINFDB followed optionally by the name of the executable file to be debugged:
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WINFDB [filename]

Unless the full path offilenameis provided, WinFDB will assume it resides in the current
working directory.

Starting from the Windows desktop
Start the debugger by double-clicking the WinFDB icon if it is present (the desktop icon
offered as an option at installation time); otherwise use the Start | Programs... dialog.

Starting from the ED Developer
There are two ways of starting the WinFDB debugger while in ED. You can click on the
Debug button from the toolbar, or selectTools|Debug. ED will assume the executable file
has the same name as the source file in the currently active edit window.

If prompted, enter the name of the executable file, including the filename extension (.exe )
and, if the file is not in ED’s current directory, a path. For example, if the executable fil
myprog.exe is in a directory called “programs ” below the root, you would enter

\programs\myprog.exe

Terminating the Debugger
Terminate the Debugger by selecting the Exit Debugger command from the File menu i
debugger window.
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Debugger Window
See the figure below.

Debugger Window
The following items are visible in the above figure:

1. The source code display, which shows the the lines of source code corresponding to
section of the program currently being executed. The left hand margin of this display sh
the line numbers of the code, along with symbols indicating the current line of execution
breakpoints, if any.

2. The Menu bar, used for activating all WinFDB commands.

3. The toolbar, which contains icons that activate frequently used menu commands. Th
commands can also be executed from the Menu Bar.

4. The status bar, which displays an explanation of each menu or toolbar command.

Status bar

Current line

Tool bar

of execution

Menu bar
Lahey/Fujitsu Fortran 95 User’s Guide 83



Chapter 5 Windows Debugging with WinFDB
Debugger Menus

File Menu
The table below lists the File Menu commands:

Program Menu
The table below lists the Program Menu commands.

Table 9: File Menu Commands

Command Name Function

Open Selects executable file to be debugged

Exit Debugger Terminates the WinFDB debugger

Table 10: Program Menu Commands

Command Name Function

Restart Reruns the same program.

Set Options
Specifies the argument(s) of the program to be debugged

and the runtime option(s) at execution (i.e., command-line
arguments)
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Debug Menu
The table below lists the Debug Menu commands.

Mode Menu
The table below lists the Mode Menu commands.

Table 11: Debug Menu commands

Command Name Function

Go
Runs the program to be debugged; continues an executio

that stopped due to a breakpoint, etc.

Interrupt Pauses the execution of the visual step mode.

Step In
Runs the next statement. Runs up to the beginning of the
function if the statement includes the function (i.e., “step

into”).

Step Over
Runs up to the next line, assuming the function call is one

line

Kill Stops the debugging session

Breakpoints... For displaying, setting, and clearing breakpoints.

Watch... For selecting and displaying variables during execution.

Registers Displays current values of CPU registers.

Traceback Displays the traceback information

Map Displays the modules currently loaded in memory.

Input Command...
Enter FDB commands for detailed debugging; the results

appear in the Input Command Log window. SeeFDB”Com-
mands” on page 67

Table 12: Mode Menu Commands

CommandName Function

Visual Step Activates the visual step mode
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Window Menu
The table below lists the Window Menu commands (note - the Window menu is display
only if one or more of the Debugger’s child windows are displayed):

View Menu
The table below lists the View Menu commands:

Help Menu
The table below lists the Help Menu commands:

Table 13: Window Menu commands

Command Name Function

Cascade
Displays all open windows so that they overlap,

revealing the Title Bar for each window.

Tile Horizontally Displays debug information from left to right.

Tile Vertically Displays debug information from top to bottom.

Arrange Icons
Arranges all the icons along the bottom of the win-

dow.

Close All Close all open windows

Table 14: View Menu commands

Command Name Function

Toolbar Specifies whether to display the toolbar.

Status Bar Specifies whether to display the status bar.

Table 15: Help Menu commands

Command Name Function

Help Topics Displays the help topics.

About Debugger Displays version information for the debugger.
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Using the Debugger
The debugger has the following functions:

• Starting the program to be debugged
• Setting and deleting breakpoints
• Running and stopping the program
• Displaying debug information

Starting the Program
The first step in debugging is to ensure that the program to be debugged is loaded into
debugger. If the debugger is invoked from the command line or the ED Developer with
executable file specified, the file is loaded automatically. If the executable file is not spe
fied, follow these steps:

1. Click theOpen command in theFile menu to display theOpen File dialog box.
2. In theOpen File dialog box, click or double-click the program to be debugged

(excutable file).
3. Click theOpen button.

After you complete these steps, start debugging by clicking theGo command in theDebug

menu twice; once to load the executable, and once more to begin the debug session. T
source program window will open, and the finger icon will appear at the program startin
point. If the main program is compiled without specifying the-g option, the source program
and the finger icon are not displayed.

Setting and Deleting Breakpoints

Setting a Breakpoint
You can stop program execution at any point by setting a breakpoint, allowing the statu
variables and registers to be examined. A breakpoint can only be set on an executable l
code; it cannot be set at a comment or variable declaration, for example.

Start the program to be debugged and set the breakpoint when debugging enters start
To set a breakpoint at a line, position the mouse pointer on the line number in the source
gram and click the left mouse button.

A breakpoint can also be set as follows:

1. Select the Breakpoints command from theDebug menu to display theBreakpoints dia-
log box (see the figure below).

2. In the Position field in the Breakpoints dialog box, specify the line number for which t
breakpoint is to be set.
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3. Click theAdd button.

4. Check that the line number appears in the breakpoint list; then click theOKbutton.

5. The above step displays the breakpoint (flag) in the displayed source program. To s
breakpoint for another line number, repeat steps (2) and (3).

Releasing the Breakpoint
Some or all breakpoints that have been set can be deleted.

To delete a breakpoint at a line, position the pointer on the line number in the source pro
(indicated with a flag) and click the left button.

A breakpoint can also be deleted as follows:

1. Select theBreakpoints command from theDebug menu to display the Breakpoints
dialog box.

2. In theBreakpoints List field in the Breakpoints dialog box, click the line number
to be deleted.

3. Click theDelete button, then theOKbutton.

All breakpoints can be deleted as follows:
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1. Select theBreakpoints command from theDebug menu to display the Breakpoints
dialog box.

2. Click theClear button in the Breakpoints dialog box, then click theOKbutton.

Running and Stopping the Program

Running the Program
To run the program until the first (or next) breakpoint, select theGo command from the
Debug menu. To step one line, entering a function call if present (“step into”), select theStep

command from theDebug menu. To step one line and treat a function call as one instructi
(“step over”), select theNext command from theDebug menu.

You can execute the program in “Visual Step Mode” by using theVisual Step command
in theMode menu. Visual Step Mode allows you to run the program “slow motion”, seei
each step as it is executed, and it works as follows:

When you select theGo command from theDebug menu in the visual step mode, the finger
icon moves line by line as the program is executed. This provides a means of visually ch
ing the program execution sequence. To pause the execution in the visual step mode,
the Interrupt command from theDebug menu.

Stopping the Program
To stop the program, select theKill command from theDebug menu. The “debugging
enabled” status is released.

To restart debugging, see below.

Rerunning the Program
To restart debugging, reload the program by selecting theRestart command from thePro-

gram menu.

Then, start the program by selecting theGo command from theDebug menu.

Displaying Debug Information
The debugger can display the following debug information:

• Variables
• Registers
• Traceback
• Load map
• Output

The displayed debug information is updated at the following times:
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• When a step run or line run is executed.
• When a program is stopped at a breakpoint.
• When a program running in the visual step mode is paused.

The display method for each type of debug information is listed below.

Displaying Variables
Do the following to display the contents of variables:

1. Select the Watch command from the Debug menu to display the Watch dialog box
(see the figure below).

2. In the Variable field, specify the variable to be displayed.
3. Click the Add button. The specified variable is then registered in the variable field.

When the program is executed, the current variable contents are displayed on the
right-hand side of the “=” symbol.

Variable contents are not displayed when any of the following is true:

• The program to be debugged has not been started.
• The local variable of another function or routine was specified.
• A non-used variable was specified.

To delete the registered variable, do one of the following:

1. In the Variable field, specify the variable name to be deleted and click the Delete
button.

2. Click the registered variable, then click the Delete button. If you click the Delete but-
ton without clicking a variable, the first variable in the variable field is deleted.

To delete all the variables registered in the variable field, click the Clear button.
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Displaying Registers
Do the following to display the register contents:

1. Select the Registers command from the Debug menu.

The current register contents are displayed in the Registers window (see the figure bel

Displaying a Traceback
Do the following to display a traceback:

1. Select the Traceback command from the Debug menu.

The current traceback information is displayed in the Traceback window (see the figure
below).
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Displaying a Load Map
Do the following to display a load map:

1. Select the Map command from the Debug menu.

The current loaded modules are displayed in the Map window (see the figure below).

Entering FDB Commands
Do the following to enter FDB commands for more detailed debugging activity:

1. Select the “Input Command” command from the Debug menu.
2. Type a command in the “Command” field in the “Input Command” dialog, or select

a command from the drop-down command history, or simply click OK to repeat the
last command (see FDB”Commands” on page 67).
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The messages and results are displayed in the Input Command Log window (see the fi
below).

Restrictions
1. The Debugger will not debug a program that has been compiled by another vendor’s
piler, even if their debug option is specified. Other vendor’s debuggers will not debug a
program that has been compiled by LF95, even if the debug option (-g ) is specified.

2. You can combine objects compiled by the Fujitsu Compiler with objects compiled by
tain other compilers (see”Mixed Language Programming”on page 38). However, WinFDB
will not step into those parts of the programs which were compiled by the other vendor’
compiler.

3. An adjustable array that is a dummy argument cannot be debugged if it appears at th
beginning of a procedure or a function.

Example:
line number
1 subroutine sub(x,y,i)
2 real x(5:i)
3 real y(i+3)

In this example, adjustable arraysx andy cannot be debugged where the beginning of the
procedure is sub(line number 1).
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4. The dummy argument of a main entry cannot be debugged at the sub entry.

Example:
subroutine sub(a,b)

:
:

entry ent(b)

In this example, the dummy argumenta, which is in the main entry’s argument list but not in
the sub entry ent, cannot be debugged. However, the dummy argument b, which is pas
the sub entry ent, can be debugged.

5. A breakpoint cannot be set for an executable statement in an include file.

6. An array of an assumed size can be debugged only for the lower boundary.

7. A label cannot be debugged.

8. In include files that contain expressions or a #line statement, the C programs canno
debugged.

9. When in a Fortran program the continue statement has no instruction, the breakpoin
automatically set at the next statement.

Example:
line number
1 integer i
2 :
3 assign 10 to i
4 10 continue
5 i=1

In the above example, if you set a breakpoint at line 4, the breakpoint is actually set at li

10. If a Fortran program has a contains statement, the breakpoint cannot be set at its e
statement.

11. If the result of a function is one of the following, the step and next commands have
effect:

- array
- derived type
- pointer
- character whose length is not a constant

12. An allocated array cannot be debugged except for the first element of the array.

13. If a pointer variable is a common element, the pointer variable cannot be debugged

Example:
common /com/p
pointer (p,j)
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The above variable j cannot be debugged.

14. A dummy argument declared with the entry statement in a procedure cannot be debu
except for the first element of the explicit-shape array and the top of the assumed type p
eter string (including the pointervariable).

Example:
subroutine s1(a,i,c)
real a(i)
character*(*) c

:
entry ent(b,j,d)

The above cannot be debugged excepta(1) andc(1:1) .

15. When debugging a program using the VSW function, please note that Execution sh
be used to restart the execution after returning from the call-back routine. If Step or Lin
used to restart the execution, breakpoints may not be ignored.

Other Remarks
1. In source level debugging, the executable file (.EXE) and its debugging information f
(.YDG) must exist in the same directory. In the same way, the dynamic link library (.DL
and its debugging information file must exist in the same directory.

2. In source level debugging, the prolog instructions of each function may cause the fo
ing features not to work correctly:

- traceback indication
- next command

3. When searching the source files, the Debugger refers to the environment variable
FDB_SRC_PATH. There are two ways of specifying the environment variable:

Example 1: In the command prompt
c:\> set FDB_SRC_PATH=c:\users\fujitsu\prog;d:\common\lib\src
c:\> winfdb

The above specifies the full pathnames of the directory in which the source files exist. If th
are more than two directories, you may specify them with the separator ";". Then, invoke
Debugger.

Example 2: In the Control Panel (Windows NT only)
Variable(V): FDB_SRC_PATH
Value(A): c:\users\fujitsu\prog;d:\common\lib\src

The above specifies environment variable FDB_SRC_PATH to each user’s environme
variable of the System in the Control Panel. In Windows 95/98, specify the environment
able FDB_SRC_PATH in AUTOEXEC.BAT.
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4. If the debug option is specified when linking, object filenames must be specified with
pathnames except for the objects in the current directory.

5. If objects are linked with the debug option and static link libraries are in a different dir
tory from the object files and debugging information files(.YDG), to debug the executab
file, specify the full path-names of the object files and the debugging information file to
environment variable FDB_MERG_PATH.

Example: Specify the environment variable FDB_MERG_PATH
set FDB_MERG_PATH=c:\users\fujitsu;e:\apl\users\lib\obj

In the above, the directory name is specified with full pathnames separated by a semic

Note: The object file and debugging information file are searched as follows:

1. The directories specified in the environment variable FDB_MERG_PATH.

2. The directories which store the user’s library.
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The Lahey Librarian, LM, can be used to create, modify, and inspect object library files
Command-Line Syntax

LM [old-library-name][switches] [commands] [, [list-filename][,[new-library-name]];

Where:

old-library-nameis the name of an existing library used as input.

switchesis zero or more command-line switches (described below).

commandsis zero or more commands (described below).

list-filenameis the name of the listing file.

new-library-nameis the name of a new library to create if you do not want to update the o
library.

A file name can be specified on the command line as a complete file name (filename. ext) or
can be given without an extension, in which case 386|LIB supplies a default extension
.obj for an object file and.lib for a library. There is no default extension for a listing file.
In addition, a complete or partial path may be specified with the file name. If none is giv
the current default device and directory are assumed.

There should be no delimiter between multiple commands or switches.

Switches

/EXTRACTALL
The /EXTRACTALL switch extracts all object modules from a specified library. Each
extracted object module becomes an object file.
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Example
LM mylib/extractall;

/PAgesize
The /PAgesize switch allows you to specify the page size (in bytes) of a library. Specify
a bigger page size will enable you to store more objects. A smaller page size will result
smaller library. The default page size is either 16 bytes or the page size of the existing
library.Valid page sizes are integral powers of 2 from 16 to 32768, inclusive. The syntax
/PAgesize is:

/PA[gesize] :page-size

wherepage-sizeis the page size in bytes.

Example
LM mylib/pa:16384;

/Help
The /Help switch prints a summary of syntax and usage for the library manager. The sy
for /Help is:

/H[elp]

Example
LM/H;

Commands

Add Modules
The addition symbol (+) appends the object file(s) following each ‘+’ symbol to the end of
the library. Pathnames can be used if the object file is not in the current directory.

Example
LM mylib +myobj;

The objectmyobj.obj is added tomylib.lib .

Delete Modules
The subtraction symbol (- ) preceding an object module name deletes that module from t
library specified withold-library-name.
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LM mylib -myobj;

The object modulemyobj is deleted frommylib.lib .

Replace Modules
The subtraction and addition symbols (-+ ) combine to form the Replace Modules command
The Replace Modules command, followed by an object module name, replace that mo
by deleting it from the library and then appending an object file with the same name as
deleted module to the library.

Example
LM mylib -+myobj-+myobj2;

The object modulesmyobj andmyobj2 are replaced withmyobj.obj andmyobj2.obj .

Copy Modules
The asterisk symbol (* ) copies the module following the asterisk into an object file with th
same name.

Example
LM mylib *myobj;

The object modulemyobj from mylib.lib is copied tomyobj.obj . The object module
myobj in the library is unaffected.

Move Modules
The subtraction symbol followed by an asterisk (-* ) forms the Move Modules command,
which moves a specified object module to an object file of the same name.

Example
LM mylib -*myobj-*myobj2;

The object modulesmyobj andmyobj2 are deleted frommylib.lib andmyobj.obj and
myobj2.obj are created.

Response Files
It is possible to place commonly used or long LM command-line parameters in a respo
file. LM command-line parameters are entered in a response file in the same manner as
would be entered on the command line. A new line in a response file is treated like a com
Lahey/Fujitsu Fortran 95 User’s Guide 99



Chapter 6 LM Librarian

com-
ct

ill
The
on the LM command line. The ampersand character (&) is used to continue a line in a
mand file. The ampersand character is valid only after an object module name or obje
filename. A blank line is interpreted as the end of input to LM.

To invoke the response file, type:

LM @response-filename

whereresponse-filenameis the name of the response file.

Example
oldlib
+object+object2-module3&
*module4
listfile.lst
newlib

This adds the objectsobject andobject2 to what was inoldlib.lib , removes
module3 , and copiesmodule4 to module4.obj . The listing file is written to
listfile.lst and the new library is callednewlib.lib .

Interactive Mode
LM can be operated in interactive mode by typing just LM at the command prompt. You w
be prompted for input. The ampersand character is used to continue a long line of input.
following session would perform the same operations as the command file above:

Example
lm
Library name: oldlib
Operations desired: +object+object2-module3&
Operations desired: *module4
List filename: listfile.lst
Output library name: newlib
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Introduction

What Does It Do?
AUTOMAKE is a simple-to-use tool for re-building a program after you have made chan
to the Fortran and/or C source code. It examines the creation times of all the source, ob
and module files, and recompiles wherever it finds that an object or module file is non-e
tent, empty or out of date. In doing this, it takes account not only of changes or addition
the source code files, but also changes or additions to MODULEs and INCLUDEd files
even when nested. For example, if you change a file which is INCLUDEd in half a doze
source files, AUTOMAKE ensures that these files are re-compiled. In the case of Fortran
AUTOMAKE ensures that modules are recompiled from the bottom up, taking full acco
of module dependencies.

How Does It Do That?
AUTOMAKE stores details of the dependencies in your program (e.g. fileA INCLUDEs file
B) in a dependency file, usually called 'automake.dep '. AUTOMAKE uses this data to
deduce which files need to be compiled when you make a change. Unlike conventiona
MAKE utilities, which require the user to specify dependencies explicitly, AUTOMAKE
creates and maintains this data itself. To do this, AUTOMAKE periodically scans sourc
files to look for INCLUDE and USE statements. This is a very fast process, which adds v
little to the overall time taken to complete the update.

How Do I Set It up?
The operation of AUTOMAKE is controlled by a configuration file which contains the
default compiler name and options, INCLUDE file search rule, etc. For simple situation
where the source code to be compiled is in a single directory, and builds into a single ex
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able, it will probably be possible to use the system default configuration file. In that case t
is no need for any customization of AUTOMAKE— just type 'am' to update both your pro-
gram and the dependency file.

In other cases, you may wish to change the default compiler name or options, add a sp
link command, or change the INCLUDE file search rule; this can be achieved by customi
a local copy of the AUTOMAKE configuration file. More complex systems, perhaps invo
ing source code spread across several directories, can also be handled in this way.

What Can Go Wrong?
Not much. AUTOMAKE is very forgiving. For example, you can mix manual and AUTO
MAKE controlled updates without any ill effects. You can even delete the dependency
without causing more than a pause while AUTOMAKE regenerates the dependency da
fact, this is the recommended procedure if you do manage to get into a knot.

Running AUTOMAKE
To run AUTOMAKE, simply type 'am'. If there is a configuration file (AUTOMAKE.FIG) in
the current directory, AUTOMAKE reads it. Otherwise, it starts the AUTOMAKE Config
uration file editor, AMEDIT.EXE.

The AUTOMAKE Configuration File Editor
The AUTOMAKE Configuration File Editor (AMEDIT) is a Windows-based utility for cre
ating and maintaining configuration files for use by AUTOMAKE. You can start it from
Windows 95 or NT command prompt by typing

amedit

to create a new file, or

amedit myproject.fig

to edit an existing one. AMEDIT is also started automatically when AUTOMAKE first run
in a directory with noAUTOMAKE.FIGfile.
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If you are creating a new file, the editor first presents a dialog containing a set of options
able for most simple projects. The defaults are:

• to use LF95 with switches set for debugging. You can select other options, including
LF95 with switches set for optimization, from the drop-down list.

• to compile all files fitting*.f90 in the current directory. This can be changed, for
example to*.for , by typing in the second box.

• to create an executable file calledtarget.exe . This can be changed by typing in
the third box, or by using the file selection dialog (click on the button at the right of
the box).

When you are finished, click “OK” to create the file.

If your project is more complicated than that—for example if you have files in more than o
directory, or you need special linker instructions—click on the “Editor” button and a new d
log with many more possibilities is displayed.
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The pane on the left-hand side lists the sections in theAUTOMAKE.FIGfile. When you click
on the section in the left-hand pane, details appear in the right hand pane. Typically the
a general section, which specifies options, such as debug switches, which relate to the
process. One or more compilation sections follow this, each specifying a set of files to
compiled together with the compiler options. Finally, there is usually a link section, in wh
the link command is specified.

The link section, shown above, allows you to enter the executable file name and the link
mand (see”LINK=” on page 109 for an explanation of place markers such as%rf and%ex).
There is a drop-down list of linker options which, once selected, can be added to the link
mand by clicking on the ‘+’ button. Finally, you can add comments as required in the bo
the bottom of the right-hand pane.

Compilation sections are similar to link sections, but with a few more options:
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This time you must specify the files to be compiled (see”FILES=” on page 107) and the
compile command (see”COMPILE=” on page 107). As in the LINK section, there is a
drop-down list of compiler options that can be appended to the compile command by clic
on the ‘+’ button.

The other entries are all optional. They are:

• The directories to be searched for INCLUDE files (see”INCLUDE=” on page 110)

• The target directory for object files (see”OBJDIR=” on page 110)

• The object file extension (see”OBJEXT=” on page 110)

• The target directory for.MODfiles (see”MODULE=” on page 110)

• Comments

New compilation sections can be added by clicking on “Add Compilation”, and deleted
clicking on “Delete Phase”. The order of compilation sections can be changed using th
arrow buttons at the bottom left.

The General Section includes three check boxes:
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• To specify whether AUTOMAKE should continue after a compilation error (see
”QUITONERROR” on page 111 and”NOQUITONERROR” on page 111).

• To specify whether debugging data should be written to a file calledAUTOMAKE.DBG

(see”DEBUG” on page 111).

• To specify whether a simple make file called AUTOMAKE.MAK should be written
as an aid to debugging (see”MAKEMAKE” on page 111).

The Advanced button gives access to options that are not relevant for LF95.

The AUTOMAKE Configuration File
The AUTOMAKE configuration file is used to specify the compile and link procedures, a
other details required by AUTOMAKE. It consists of a series of records of the form

keyword=value
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wherekeywordis an alphanumeric keyword name, andvalueis the string of characters
assigned to the keyword. The keyword name may be preceded by spaces if required.
record with a '#', '! ' or '* ' as the first non-blank character is treated as a comment.

The keywords which may be inserted in the configuration file are:

LF95

Equivalent to specifying the default LF95 compile and link commands.

COMPILE=@lf95 -c %fi -mod %mo

LINK=@lf95 %ob -exe %ex -mod %mo

TheLF95 keyword should appear in anyautomake.fig file that is to be used with LF95.

FILES=

Specifies the names of files which are candidates for re-compilation. The value field sh
contain a single filename optionally including wild-cards. For example,

FILES=*.f90

You can also have multiple FILES= specifications, separated by AND keywords.

FILES=F90\*.F90

AND

FILES=F77\*.FOR

AND

...

Note that, with each new FILES= line. the default COMPILE= is used, unless a new CO
PILE= value is specified after the FILES= line and before AND.

Note also that, if multiple FILES= lines are specified, then the %RF place marker canno
used in any COMPILE= lines.

COMPILE=

Specifies the command to be used to compile a source file. The command may contain
markers, which are expanded as necessary before the command is executed. For exam

COMPILE=@lf95 -c %fi
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The string '%fi ' in the above example is a place marker, which expands to the full name
the file to be compiled. The following table is a complete list of place markers and their
meanings:

COMPILE=@lf95 -c %fi -mod %mo

COMPILE=@lf95 -c @%rf -I %id

It is possible to invoke the compiler using a command file (batch file, shell script etc.). H
ever, on PCs, it is necessary to preface the batch file name with 'CALL' or 'COMMAND/C'. For
example

COMPILE=CALL fcomp %fi

Note that with LF95 the -c switch should always be used in a COMPILE= line.

Table 16: COMPILE= Place Markers

Place Marker Meaning

%SD expands to the name of the directory containing the source file -
including a trailing '\ '.

%SF expands to the source file name, excluding the directory and exten-
sion.

%SE expands to the source file extension—including a leading '. '. For
example is the file to be compiled is 'f:\source\main.for ', %SD

expands to 'f:\source\ ', %SFto 'main ', and%SEto '.for '.

%OD expands to the name of the directory containing object code, as spe
ified using theOBJDIR= command (see below), including a trailing
'\ '.

%OE expands to the object file extension, as specified using theOBJEXT=

command (see below), including a leading '. '.

%ID expands to the INCLUDE file search list (as specified using
INCLUDE=(see below))

%MO expands to the name of directory containing modules (as specified
usingMODULE=(see below))

%RF expands to the name of a response file, created by AUTOMAKE,
containing a list of source files. If%RFis present, the compiler is
invoked only once.

%FI is equivalent to%SD%SF%SE
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TARGET=

Specifies the name of the program or library file which is to be built from the object cod
Note that you will also have to tell the linker the name of the target file. You can do this us
a %EXplace marker (which expands to the file name specified usingTARGET=).

TARGET=f:\execs\MYPROG.EXE

If there is noTARGET=keyword, AUTOMAKE will update the program object code, but wil
not attempt to re-link.

LINK=

Specifies a command which may be used to update the program or library file once the o
code is up to date:

LINK=@lf95 %ob -exe %ex -mod %mo'

LINK=@lf95 %od*%oe -exe %ex -mod %mo'

LINK=@lf95 %rf -exe %ex -mod %mo'

You could use a batch file called 'l.bat ' by specifying

LINK=CALL L

The following place markers are allowed in the command specified usingLINK= .

Table 17: LINK= Place Markers

Place Marker Meaning

%OD
expands to the name of the directory containing object code, as sp
ified using theOBJDIR= command (see below), including a trailing
'\ '.

%OE
expands to the object file extension, as specified using theOBJEXT=

command (see below), including a leading '. '.

%OB
expands to a list of object files corresponding to source files speci-
fied using allFILES= commands.

%EX expands to the executable file name, as specified usingTARGET=.

%MO
expands to the name of directory containing modules (as specified
usingMODULE=(see below))

%RF
expands to the name of a response file, created by AUTOMAKE,
containing a list of object files.
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INCLUDE=

May be used to specify the INCLUDE file search list. If no path is specified for an
INCLUDEd file, AUTOMAKE looks first in the directory which contains the source file, an
after that, in the directories specified using this keyword. The directory names must be
arated by semi-colons. For example, on a PC, we might have:

INCLUDE=C:\include;C:\include\sys

Note that the compiler will also have to be told where to look for INCLUDEd files. You ca
do this using a%ID place marker (which expands to the list of directories specified using
INCLUDE).

SYSINCLUDE=

May be used to specify the search list for system INCLUDE files (i.e. any enclosed in an
brackets), as in

#include <stat.h>

If no path is specified, AUTOMAKE looks in the directories specified using this keyword
does not look in the current directory for system INCLUDE files unless explicitly instruct
to. The directory names followingSYSINCLUDE=must be separated by semi-colons.

OBJDIR=

May be used to specify the name of the directory in which object files are stored. For
example,

OBJDIR=OBJ\

The trailing '\ ' is optional. IfOBJDIR= is not specified, AUTOMAKE assumes that source
and object files are in the same directory. Note that if source and object files are not in
same directory, the compiler will also have to be told where to put object files. You can
this using a%ODplace marker (which expands to the directory specified usingOBJDIR).

OBJEXT=

May be used to specify a non-standard object file extension. For example to specify th
object files have the extension '.abc ', specify

OBJEXT=ABC

This option may be useful for dealing with unusual compilers, but more commonly to al
AUTOMAKE to deal with processes other than compilation (for example, you could use
AUTOMAKE to ensure that all altered source files are run through a pre-processor prio
compilation).

MODULE=

May be used to specify the name of the directory in which module files are stored.

MODULE=MODS\
110 Lahey/Fujitsu Fortran 95 User’s Guide



Multi-Phase Compilation

the
do

,
90

lica-

are
direc-
eed
The trailing '\ ' is optional. IfMODULE=is not specified, AUTOMAKE assumes that source
and module files are in the same directory. Note that if source and module files are not in
same directory, the compiler will also have to be told where to put module files. You can
this using a%MOplace marker (which expands to the directory specified usingMODULE=).

DEP=

May be used to over-ride the default dependency file name.

DEP=THISPROG.DEP

causes AUTOMAKE to store dependency data in 'thisprog.dep ' instead of
'automake.dep '.

QUITONERROR

Specifies that AUTOMAKE should halt immediately if there is a compilation error.

NOQUITONERROR

Specifies that AUTOMAKE should not halt if there is a compilation error.

MAKEMAKE

Specifies that AUTOMAKE should create a text file calledAUTOMAKE.MAKcontaining
dependency information.

DEBUG

Causes AUTOMAKE to write debugging information to a file calledAUTOMAKE.DBG.

LATESCAN

Delays scanning of source files until the last possible moment, and can, in some cases
remove the need for some scans. However this option is NOT compatible with Fortran
modules.

CHECK=

May be used to specify a command to be inserted after each compilation. A typical app
tion would be to check for compilation errors. For example, under MS-DOS:

CHECK=IF ERRORLEVEL 2 GOTO QUIT

would cause the update procedure to abort if there is a compilation error.

Multi-Phase Compilation
Sometimes, more than one compilation phase is required. For example, if source files
stored in more than one directory, you will need a separate compilation phase for each
tory. Multiple phases are also required if you have mixed C and Fortran source, or if you n
special compilation options for particular source files.
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The 'AND' keyword may be inserted in your configuration file to add a new compilation pha
You can reset the values ofFILES= , COMPILE=, INCLUDE=, OBJDIR=, OBJEXT=andMOD-

ULE= for each phase. All default to the value used in the previous phase, except that
OBJDIR= defaults to the new source directory.

The following example shows how this feature might be used with the LF95 compiler. T
same principles apply to other compilers and other platforms.

# Example Configuration file for Multi-Phase
# Compilation
# Compilatio n 1 - files in current directory
LF95
INCLUDE=\include
FILES=*.f90
OBJDIR=obj
COMPILE=@lf95 -c %fi -i %id -o %od%sf%oe -tp -o1
AND
# Compilatio n 2 - files in utils\
# INCLUDE= defaults to previous value (\include)
# if OBJDIR= were not set, it would default to utils (NOT obj)
FILES=utils\*.f90
OBJDIR=utils\obj
COMPILE=@lf95 -c %fi -i %id -o %od%sf%oe -sav -chk
# Relink
TARGET=current.exe
LINK=@lf95 %ob -exe %ex

Automake Notes
• As AUTOMAKE executes, it issues brief messages to explain the reasons for all

compilations. It also indicates when it is scanning through a file to look for
INCLUDE statements.

• If for any reason the dependency file is deleted, AUTOMAKE will create a new one.
Execution of the first AUTOMAKE will be slower than usual, because of the need
to regenerate the dependency data.

• AUTOMAKE recognizes the INCLUDE statements in all common variants of For-
tran and C, and can be used with both languages.

• When AUTOMAKE scans source code to see if it contains INCLUDE statements, it
recognizes the following generalized format:

• Optional spaces at the beginning of the line followed by..

• An optional compiler control character, '%', '$' or '#', followed by..

The word INCLUDE (case insensitive) followed by..
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An optional colon followed by..

The file name, optionally enclosed between apostrophes, quotes or angled brackets
If the file name is enclosed in angled brackets, it is assumed to be in one of the direc
tories specified using the SYSINCLUDE keyword. Otherwise, AUTOMAKE looks
in the source file directory, and if it is not there, in the directories specified using the
INCLUDE keyword.

• If AUTOMAKE cannot find an INCLUDE file, it reports the fact to the screen and
ignores the dependency relationship.

• AUTOMAKE is invoked using a batch file calledAM.BAT. There is seldom any rea-
son to modify the command file, though it is very simple to do so if required. It
consists of two (or three) operations:

Execute AUTOMAKE. AUTOMAKE determines what needs to be done in order to
update the system, and writes a batch file to do it. The switches which may be
appended to the AUTOMAKE command are:

TO=specifies the name of the output command file created by AUTOMAKE.

FIG= specifies the name of the AUTOMAKE configuration file.

Execute the command file created by AUTOMAKE.

Delete the command file created by AUTOMAKE. This step is, of course, optional.
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Tuning a program can significantly reduce its execution time. A specific section of a prog
may take most of the processing time, so tuning that section may greatly speed up the
cessing of the program. The Sampler tool helps you tune programs and detect bottlene

Remarks:

1. When you tune a program, start by checking the cost for each function. If the cost of a
tion is high, the following two factors may be causes:
a. The function may include a redundant section.
b. The function itself may have no problems; however, it may be called excessively.

For the first cause, check the cost of the function source. For the second cause, check
source cost of the function calling this function.

2. Thecostdescribed in this chapter is the summed result of execution locations extracted
a specific time unit (per second, for example) based on a given sampling frequency. To
trate, the cost of function f in a program is the number of locations belonging to f from t
locations extracted per a specific time value.

Starting and Terminating the Sampler

Starting the Sampler
There are two ways to start the sampler:

1. From the Windows desktop icon
2. From the Windows command prompt

Starting from the Sampler icon
Start the sampler by double-clicking the Sampler icon on your Windows desktop if you ch
to have an icon at installation time; otherwise start it from theStart|Programs menu.
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Starting from the Command prompt
Type

SAMP

followed by the <Enter> key.

Terminating the Sampler
To terminate the sampler, choose the Exit Sampler command from the File menu in the
pler window.

The Sampler Window
See the figure below for the sampler window.

The above figure illustrates the following items:

1. The Toolbar, which contains icons that activate frequently used commands. These
commands can also be executed from the Menu Bar.
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2. The Status Bar, which displays an explanation of each menu command.
3. The “Function Cost” and “Calling Tree” windows, which are described later in this

chapter.

Sampler Menus
The sampler menus are outlined below.

File Menu
The table below lists the File menu commands.

Remarks:

• The “Print” and “Print Preview” commands are displayed only if tuning information
is being displayed.

• The “Print” and “Print Preview” commands cannot be used for the function calling
relationship diagram.

Table 18: Commands for the File Menu

Command Function

Select Files
Opendialogforselectingexecutable(.exe)

file and specifying sampling data output (.smp) file.

Print Print the displayed tuning information

Print Preview Display pages as they would appear if printed

Print Setup Configure the printer

Exit Sampler Terminate the Sampler
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Sampler Menu
The table below lists the Sampler menu commands.

View Menu
The table below lists the View menu commands.

Table 19: Commands in the Sampler Menu

Command Function

Execute Run the program to collect tuning information

Executing Options
Specify command line arguments and runtime

options to the program and execute the program to
collect tuning information

Function Cost Display the cost for each function

Source Cost Display the cost for each program unit

Calling Tree
Display the function calling relationship diagram

(calling tree)

Program Type: Fortran
Specify whether to display Fortran program

information for the Sampler Data

Program Type: C
Specify whether to display C program

information for the Sampler Data

Program Type: Other
Specify whether to display information other than C

or Fortran program information for the Sampler
Data.

Source File Directory Specify the source file directory

Table 20: Commands in the View Menu

Command Function

Status Bar Specify whether to display the status bar.

Toolbar Specify whether to display the toolbar.

File Information Specify whether to display file information
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Window Menu
The table below lists the Window menu commands.

Note: the Window menu is displayed only if tuning information is being displayed.

Help Menu
The table below lists the Help menu commands.

Using the Sampler
The functions of the sampler are listed below. This section explains how to use these
functions.

• Collecting the tuning information
• Displaying the tuning information

Table 21: Commands in the Window Menu

Command Function

Cascade
Display all open windows so that they overlap,

revealing the Title bar for each window.

Tile Horizontally
Display the listed tuning information from left to

right.

Tile Vertically
Display the listed tuning information from top to

bottom.

Arrange Icons
Arrange all the icons along the bottom of the win-

dow.

Close All Close all open windows

Table 22: Commands in the Help Menu

Command Function

Help Topics Display the Sampler help topics

About Sampler Display version information for the Sampler.
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Collecting Tuning Information
In order to generate tuning information, the program must be compiled with the-trace

option (see”-[N]TRACE” on page 33). To collect tuning information, run the program onc
following the steps outlined below:

1. In the sampler, select the “Select Files...” command from the File menu. The Select
Files dialog box appears.

2. Specify the Sample Data File, either by typing it in or browsing. The file must have
an extension of .smp. Note that selection through browsing will set the default
directory.

3. Specify the Executable File, either by typing it in or browsing. The file must have an
extension of .exe.

4. Select one of the following methods of running the program:

To run the program with the existing execution options:
a. Select the “Execute” command from the Sampler menu to run the program and col

lect its tuning information, allowing the program to terminate normally.
b. To abort execution, click the Stop button in the window that is displayed while the

program is running (this may interfere with generation of sampler data).

To run the program with modified execution options (i.e., command-line arguments):
a. Select the “Executing Options” command from the Sampler menu. The Executing

Options dialog box appears.
b. In the Executing Options dialog box, specify the executing option. If the user pro-

gram uses default input-output, specify a redirection function such as “<“ or “>” in
the executing option.

c. Click the OK button.
d. Execute the program and collect its tuning information, allowing it to terminate

normally.
e. To abort execution, click the Stop button in the window that is displayed while the

program is running (this may interfere with generation of sampler data).

Note: In Windows 9x, if the message “Out of environment space” is displayed while runn
a console-mode program from the Sampler, it means the environment space of the DOS
must be increased. This may be accomplished by by adding the line (assuming that the s
install directory is “c:\windows”)

SHELL=C:\WINDOWS\COMMAND.COM /P /E:32768

to the CONFIG.SYS file. It may also be accomplished by modifying the “Initial Environ-
ment” property of the file COMMAND.COM using Windows explorer.

Displaying Tuning Information
The sampler displays the following three items of tuning information.
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• Cost for each function

• Cost per line of the source level

• Function calling relationship diagram

Recompilation is not required for an object generated with the Fujitsu Fortran compiler.
use the C compiler, specify the /Kline option at compilation.

The method of displaying each item of information is listed below.

Displaying the Cost for Each Function
Do the following to display the cost for each program unit:

In the sampler window, select theFunction command from theDisplay menu. The func-
tion cost window appears. (See the figure below.)

Displaying the Cost Per Line
Do the following to display the cost per line of the source level:

1. In the sampler window, select the Source command from the Display menu. The Open
dialog box appears.

2. In the Open File dialog box, select the corresponding source program and click the O
button. The cost per line of the source level appears. (See the figure below for function
per line of the source level window.)

The following procedures can also be used to display the cost per line of the source lev
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Double clicking the function name that corresponds to the source code in the function c
window also shows the cost per line of the source code level.

The Calling Relationship Diagram
Do the following to display the function calling relationship diagram.

1. In the sampler window, select the Reference command from the Display menu.

2. The calling tree window appears. (See the figure below for the calling tree window.)

Click the left button in the box of file names in the calling tree window to display the Foc
and Detail menus. Select the Focus menu to display the calling relationship diagram from
function; select the Detail menu to display detailed information. If the Focus Level is m
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than 1, press the left button outside the box to display the Top Level and Previous Leve
menus. Select the Top Level menu to display the relationship diagram of jump level 1. S
the Previous Level menu to display the previous relationship diagram.

Note: The cost information per line of the source level may differ slightly from the actua
cost, because it is affected by the measuring machine status when information is collec
(such as machine load status, number of logging users, and number of demons). The co
each function always has about the same rate for the same program.
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One approach to program testing is to verify the operation range and coverage of the pro
execution. The Coverage Tool provides the following information for programs coded in
Fortran or C language:

• Executed and non-executed section information for each basic unit of execution flow
• Execution coverage information for each subroutine and function

Starting and Terminating the Coverage Tool

Starting the Coverage Tool
There are two ways to start the Coverage Tool:

1. From the Windows desktop icon
2. From the Windows command prompt

Starting from the desktop icon
Start by double-clicking the Coverage Tool icon on your Windows desktop if you chose
have an icon at installation time; otherwise start it from theStart|Programs menu.

Starting from the Command prompt
Type

COV

followed by the <Enter> key.

Terminating the Coverage Tool
In the coverage window, terminate the coverage tool by selecting the Exit Coverage co
mand from the File menu.
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Coverage Window
See the figure below for the coverage window.

The above figure illustrates the following items:

1. The Toolbar, which contains icons that activate frequently used commands. These c
mands can also be executed from the Menu Bar.

2. The Status Bar, which displays an explanation of each menu command.

Coverage Menus
The coverage menus are outlined below.
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File Menu
The table below lists the File menu commands.

Note: the Print, and Print Preview commands are displayed only if coverage informatio
being displayed.

Coverage Menu
The table below lists the Coverage menu commands.

Table 23: Commands in the File Menu

Command Function

Select Files
Opendialogforselectingexecutable(.exe)

file and specifying coverage data output (.cov) file

Print Print the coverage information being displayed.

Print Preview Display image as it would be printed

Print Setup Specify printer configuration.

File Search Path Specify the path for searching for the file.

Exit Coverage Terminate the coverage tool.

Table 24: Commands in the Coverage Menu

Command Function

Execute Run the program to collect coverage information.

Executing
Options

Submit command line argument(s) and runtime
options to the program and execute the program to

collect coverage information

Execution
Coverage Rate

Displaythecoverageinformationforall
program units

Source File
Directory

Specify the source file directory
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View Menu
The table below lists the View menu commands.

Window Menu
The table below lists the Window menu commands.

Note: the Window menu is displayed only if coverage information is being displayed.

Help Menu
The table below lists the Help menu commands.

Table 25: Commands in the View Menu

Command Function

Status Bar Specifies whether to display the status bar.

Toolbar Specifies whether to display the toolbar.

Table 26: Commands in the Window Menu

Command Function

Cascade
Displays all open windows so that they overlap,

revealing the Title Bar for each window.

Tile Horizontally
Displays the listed coverage information from left to

right.

Tile Vertically
Displays the listed coverage information from top to

bottom.

Arrange Icons
Arranges all the icons along the bottom of the win-

dow.

Close All Close all open windows

Table 27: Commands in the Help Menu

Command Function

Help Displays the Coverage Tool help topics

About Coverage Displays version information for the coverage tool.
128 Lahey/Fujitsu Fortran 95 User’s Guide



Using the Coverage Tool

ify

-

s):
Using the Coverage Tool
To compile a source program for the collection of coverage information, you must spec
-cover as an option at compilation. If the source program is compiled without the-cover

option specified, coverage information is not collected.

The coverage functions are listed below.

• Collecting coverage information
• Displaying coverage information

Collecting Coverage Information
To collect coverage information, run the program once.

Do the following to collect the information:

1. In the Coverage tool, select the “Select Files...” command from the File menu. The
Select Files dialog box appears.

2. Specify the Coverage Data File, either by typing it in or browsing. The file must have
an extension of .cov. Note that selection through browsing will set the default
directory.

3. Specify the Executable File, either by typing it in or browsing. The file must have an
extension of .exe.

4. Select one of the following methods for executing the program:

To execute the program with the existing execution options:
a. Select the “Execute” command from the Coverage menu to run the program and col

lect its coverage information, allowing the program to terminate normally.
b. To abort execution, click the Stop button in the window that is displayed while the

program is running (this may interfere with generation of coverage data).

To execute the program with modified execution options (i.e., command-line argument
a. Select the “Executing Options” command from the Coverage menu. The Executing

Options dialog box appears.
b. In the Executing Options dialog box, specify the executing option. If the user pro-

gram uses default input-output, specify a redirection function such as '<' or '>' in the
option.

c. Click the OK button.
d. Run the program and collect its coverage information, allowing the program to ter-

minate normally.
e. To abort execution, click the Stop button in the window that is displayed while the

program is executing (this may interfere with generation of coverage data).
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Note: In Windows 9x, if the message “Out of environment space” is displayed while runn
a console-mode program from the Coverage Tool, it means the environment space of
DOS shell must be increased. This may be accomplished by by adding the line (assumin
the system install directory is “c:\windows”)

SHELL=C:\WINDOWS\COMMAND.COM /P /E:32768

to the CONFIG.SYS file. It may also be accomplished by modifying the “Initial Environ-
ment” property of the file COMMAND.COM using Windows explorer.

Storing & Merging Coverage Information
Collected coverage information can be stored. You can update and display the stored
mation by assigning another argument to the executable program (merging the informa
If the program being tested requires input data, you can put sample data into a file and
use that data for testing the program.

Storing Coverage Information
Coverage information is stored in the file specified by the “Select Coverage Data File” c
mand in the File menu.

Merging Coverage Information
Follow these steps to merge coverage information with the existing coverage data file:

1. Use the “Select Coverage Data File” command in the File menu to specify the data
file containing the collected coverage information.

2. Use the “Select Executable File” command in the File menu to specify the same exe
cutable file generated by (1) above as the Executable File.

3. Select the “Execute” or “Executing Options” command from the Coverage menu to
execute the program and collect its coverage information.

The new coverage information is now stored in the specified data file.

Displaying Coverage Information
The following items are displayed in the coverage information:

• Run coverage rate for each subroutine and function
• Executed and non-executed section corresponding to the source code

Follow these steps to display the information:
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1. Select the “Select Coverage Data File” command from the File menu. The Coverage
Data File dialog box appears.

2. In the Coverage Data File dialog box, specify the coverage data file.
3. Select the “Select Executable File” command from the File menu. The Executable

File dialog box appears.
4. In the Executable File dialog box, specify the executable file.
5. Select the “Function” command from the Display menu to display the execution cov-

erage rate for each subroutine and function. (See the first figure below.) Then double
click the subroutine or function to display the executed and non-executed sections of
the corresponding source code. (See the second figure below.)
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Remarks:

1. The coverage tool shows the executed and non-executed parts of each block. A bloc
set of statements that do not change the control of execution. The following instances
separate a block:

a. Fortran: IF, CASE, DO and GOTO
b. C language: if, case, for and label

2. The following marks are placed at the beginning of the block:

a. Blue foot mark: the block which is executed for the first time
b. White foot mark: the block which is executed for the second or subsequent times.
c. Stick mark: the block that is never executed.
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This chapter documents the following utility programs:

• CFIG386.EXE

• HDRSTRIP.F90

• SEQUNF.F90

• TRYBLK.F90

• UNFSEQ.EXE

• WHICH.EXE

• RSE.EXE

CFIG386.EXE
CFIG386.EXE allows you configure switches directly into the linker to change its defau
operation. These switches are automatically processed every time the program is run.

If CFIG386 is run with the name of an linker executable file as the only argument on the c
mand line, it displays the current contents of the linker’s configuration block. If it is run
without any arguments, a list of valid CFIG386 command-line switches is displayed.

Configuring New Switches
Following the linker name, you list one or more command switches. The switches are g
in the same format they are given on the command line for the program being configure
The specified switches are added to the configuration block of the program after any swit
that are already there from any previous configurations.

Example

cfig386 386link -nomap -libpath c:\lf9550\lib
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CFIG386 does not check the values of any of the switches or switch parameters it stor
the program’s configuration block. Thus, it is possible to configure invalid switch values i
the linker. You should always run the program after configuring it to make sure that the
figured switch values have the desired effect.

-Clear
The-Clear switch causes CFIG386 to erase the current contents of the program’s con
ration block. Any switches specified after the clear switch are added to the just-cleared
configuration block.

Example
cfig386 -clear 386link

cfig386 -clear 386link -nomap

HDRSTRIP.F90
HDRSTRIP.F90 is a Fortran source file that you can compile, link, and execute with LF9
It converts LF90 direct-access files to LF95 style.

PENTEST.F90
PENTEST.F90 is a Fortran source file that you can compile, link, and execute with LF95.
tests for the Pentium flaw that affects certain floating-point operations. It will notify you
your chip exhibits the flaw.

SEQUNF.F90
SEQUNF.F90 is a Fortran source file that you can compile, link, and execute with LF95.
converts LF90 unformatted sequential files to LF95 style.

TRYBLK.F90
TRYBLK.F90 is a Fortran source file you can build with LF95. It tries a range ofBLOCK-

SIZE s and displays an elapsed time for each. You can use the results to determine an
optimum value for your PC to specify in your programs. Note that a particularBLOCKSIZE

may not perform as well on other PC’s.
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UNFSEQ.EXE
UNFSEQ.EXEis an executable file that converts LF95 unformatted sequential files to LF
style.

WHICH.EXE
WHICH.EXEis a utility to search the current directory and directories on the DOS path for
.COM, .EXE , and.BAT files matching a filename specification. It is useful for determinin
which of a number of programs or batch files with the same name will be invoked.

Syntax
which filename

wherefilenameis the name of a.COM, .EXE , or .BAT file without the extension.

Example
If the command

which make

displays the following

C:\LF9550\BIN\MAKE.EXE 47541 17:05 07-07-1994
C:\F77L3\BIN\MAKE.EXE 46237 13:16 05-22-1994

you would know that theMAKE.EXEprogram in thec:\lf9550\bin directory would be
invoked becausec:\lf9550\bin is listed beforec:\f77l3\bin on the DOS path.

RSE.EXE
RSE redirects to standard output all output which would normally go to standard error.

Syntax
rse exename

whereexenameis the name of an executable file. RSE is particularly useful when attempt
to redirect runtime error messages to a disk file. Normally, runtime error messages from
cutables created by LF95 will be sent to standard error. If you try to redirect program ou
as follows

myprog > diskfile

program output will go to the file, but runtime error messages will go only to the screen.
redirect runtime error messages to the file, use

rse myprog > diskfile
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This appendix contains information that may help you create better LF95 programs.

Efficiency Considerations
In the majority of cases, the most efficient solution to a programming problem is one tha
straightforward and natural. It is seldom worth sacrificing clarity or elegance to make a
gram more efficient.

The following observations, which may not apply to other implementations, should be c
sidered in cases where program efficiency is critical:

• Start each array dimension at zero (not at one, which is the default). Thus, declare an
arrayA to beA(0:99) , notA(100) .

• One-dimensional arrays are more efficient than two, two are more efficient than
three, etc.

• Make a direct file record length a power of two.
• Unformatted input/output is faster for numbers.
• Formatted CHARACTER input/output is faster using:

CHARACTER*256 C

than:
CHARACTER*1 C(256)

Side Effects
LF95 arguments are passed to subprograms by address, and the subprograms referenc
arguments as they are defined in the called subprogram. Because of the way argumen
passed, the following side effects can result:
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• Declaring a dummy argument as a different numeric data type than in the calling pro-
gram unit can cause unpredictable results and NDP error aborts.

• Declaring a dummy argument to be larger in the called program unit than in the call-
ing program unit can result in other variables and program code being modified and
unpredictable behavior.

• If a variable appears twice as an argument in a single CALL statement, then the cor
responding dummy arguments in the subprogram will refer to the same location.
Whenever one of those dummy arguments is modified, so is the other.

• Function arguments are passed in the same manner as subroutine arguments, so th
modifying any dummy argument in a function will also modify the corresponding
argument in the function invocation:

y = x + f(x)

The result of the preceding statement is undefined if the functionf modifies the
dummy argumentx .

File Formats

Formatted Sequential File Format
Files controlled by formatted sequential input/output statements have an undefined len
record format. One Fortran record corresponds to one logical record. The length of the
fined length record depends on the Fortran record to be processed. The max length m
assigned in the OPEN statement RECL= specifier. The carriage-return/line-feed seque
terminates the logical record. If the $ edit descriptor or \ edit descriptor is specified for t
format of the formatted sequential output statement, the Fortran record doesnot include the
carriage-return/line-feed sequence.

Unformatted Sequential File Format
Files processed using unformatted sequential input/output statements have a variable
record format. One Fortran record corresponds to one logical record. The length of the
able length record depends on the length of the Fortran record. The length of the Fortra
record includes 4 bytes added to the beginning and end of the logical record. The max le
may be assigned in the OPEN statement RECL= specifier. The beginning area is used
an unformatted sequential statement is executed. The end area is used when a BACKS
statement is executed.
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Direct File Format
Files processed by unformatted direct input/output statements have a fixed length recor
mat. One Fortran record can correspond to more than one logical record. The record le
must be assigned in the OPEN statement RECL= specifier. If the Fortran record termin
within a logical record, the remaining part is padded with binary zeros. If the length of th
Fortran record exceeds the logical record,the remaining data goes into the next record

Transparent File Format
Files opened with ACCESS=”TRANSPARENT” or FORM=”BINARY” are processed as
stream of bytes with no record separators. While any format of file can be processed t
parently, you must know its format to process it correctly.

Determine Load Image Size
To determine the load image size of a protected-mode program, add the starting addre
the last public symbol in the linker map file to the length of that public symbol to get an
approximate load image memory requirement (not execution memory requirement).

Link Time
Due to the error checking that 386LINK does, certain code can cause the linker to take lo
For example, using hundreds to thousands of named COMMON blocks causes the link
slow down. Most of the additional time is spent in processing the names themselves bec
Windows (requires certain ordering rules to be followed within the executable itself.

You can reduce the link time by reducing the number of named COMMON blocks you u
Instead of coding:

common /a1/ i

common /a2/ j

common /a3/ k

...

common /a1000/ k1000

code:

common /a/ i,j,k, ..., k1000

Link time may also be reduced by using the-NOMAPswitch.
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Year 2000 compliance
The "Year 2000" problem arises when a computer program uses only two digits to repre
the current year and assumes that the current century is 1900. A compiler can look for
cations that this might be occurring in a program and issue a warning, but it cannot fore
every occurrence of this problem. It is ultimately the responsibility of the programmer to
rect the situation by modifying the program. The most likely source of problems for Fort
programs is the use of the obsolete DATE() subroutine. Even though LF95 will compile
link programs that use DATE(), its use is strongly discouraged; the use of
DATE_AND_TIME(), which returns a four digit date, is recommended in its place.

LF95 can be made to issue a warning at runtime whenever a call to DATE() is made. T
can be accomplished by running a program with the runtime options-Wl,Ry,li for
example,

myprog.exe -Wl,Ry,li

For more information on runtime options, see”Runtime Options” on page 143.
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Limits of Operation.
Table 28: LF95 Limits of Operation

Item Maximum

program size
4 Gigabytes or available memory (includ-
ing virtual memory), whichever is smaller

number of files open concurrently
250, including pre-connected units 0, 5,
and 6

Length of CHARACER datum 65,000 bytes

I/O block size 65,000 bytes

I/O record length 2,147,483,647 bytes

I/O file size 2,147,483,647 bytes

I/O maximum number of records
2,147,483,647 divided by the value of
RECL= specifier

nesting depth of function, array section,
array element, and substring references

255

nesting depth of DO, CASE, and IF state-
ments

50

nesting depth of implied-DO loops 25

nesting depth of INCLUDE files 16
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number of array dimensions 7

array size

The compiler calculates T for each array
declaration to reduce the number of calcu-
lations needed for array sections or array
element addresses. The absolute value of
T obtained by the formula below must not
exceed 2147483647, and the absolute
value must not exceed 2147483647 for
any intermediate calculations:

n: Array dimension number
s: Array element length
l: Lower bound of each dimension
d: Size of each dimension
T: Value calculated for the array declara-
tion

Table 28: LF95 Limits of Operation

Item Maximum

T l1 s li dm 1 s×Ð

m 2=
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∏
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The behavior of the LF95 runtime library can be modified at the time of execution by a
of commands which are submitted via the command line when invoking the executable
gram, or via shell environment variables. These runtime options can modify behavior o
input/output operations, diagnostic reporting, and floating-point operations.

Runtime options submitted on the command line are distinguished from user-defined c
mand line arguments by using a character sequence that uniquely identifies the runtim
options, so that they will not interfere with the passing of regular command line argume
that the user’s program might be expecting to obtain via the GETCL(), GETPARM(), or
GETARG() functions.

Command Format
Runtime options and user-defined executable program options may be specified as com
option arguments of an execution command. The runtime options use functions support
the LF95 runtime library. Please note that these options arecase-sensitive.

The format of runtime options is as follows:

exe_file [/Wl,[runtime options],...] [user-defined program arguments]...

Whereexe_fileindicates the user’s executable program file. The string “/Wl,” (or “-Wl,”)
must precede any runtime options, so they may be identified as such and distinguished
user-defined program arguments. Note that it is W followed by a lowercase L (not the num
one). Please note also that if an option is specified more than once with different argum
the last occurrence is used.
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Command Shell Variable
As an alternative to the command line, the shell variable FORT90L may be used to spe
runtime options. Any runtime options specified in the command line are combined with th
specified in FORT90L. The command line arguments take precedence over the corres
ing options specified in the shell variable FORT90L.

The following examples show how to use the shell variable FORT90L (the actual mean
of each runtime option will be described in the sections below):

Example 1:
Setting the value of shell variable FORT90L and executing the program as such:

set FORT90L=-Wl,e99,le
a.exe -Wl,m99 /k

has the same effect as the command line

a.exe -Wl,e99,le,m99 /k

The result is that when executing the program a.exe, the runtime options e99, le, and m
and user-defined executable program argument /k are in effect.

Example 2:
When the following command lines are used,

set FORT90L=-Wl,e10
a.exe -Wl,e99

the result is that a.exe is executed with runtime option /e99 is in effect, overriding the op
e10 set by shell variable FORT90L.
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Execution Return Values
The following table lists possible values returned to the operating system by an LF95 ex
able program upon termination and exit. These correspond to the levels of diagnostic o
that may be set by various runtime options:

Standard Input and Output
The default unit numbers for standard input, output, and error output for LF95 executab
programs are as follows, and may be changed to different unit numbers by the appropr
runtime options:

Standard input: Unit number 5

Standard output: Unit number 6

Standard error output: Unit number 0

Runtime Options
Runtime options may be specified as arguments on the command line, or in the FORT
shell variable. This section explains the format and functions of the runtime options. Ple
note that all runtime options arecase-sensitive.

The runtime option format is as follows:

Table 29: Execution Return Values

Return value Status

0 No error or level I (information message)

4 Level W error (warning)

8 Level E error (medium)

12 Level S error (serious)

16
Limit exceeded for level W, E, S error, or a level U

error (Unrecoverable) was detected

240 Abnormal termination

Other Forcible termination
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/Wl [ ,Cunit] [ ,M] [ ,Q] [ ,Re] [ ,Rm:file] [ ,Tunit] [ ,a] [ ,dnum] [,enum] [,gnum] [,i]
[ ,lelvl] [ ,munit] [ ,n][ ,punit] [ ,q] [ ,runit] [ ,u] [ ,x]

When runtime options are specified, the string “/Wl” (where l is lowercase L) is required
the beginning of the options list, and the options must be separated by commas. If the
runtime option is specified more than once with different arguments, the last occurrenc
used.

Example:
a.exe /Wl,a,p10,x

Description of Options

C or C[unit]
The C option specifies how to process an unformatted file of IBM370-format floating-po
data using an unformatted input/output statement. When the C option is specified, the d
an unformatted file associated with the specified unit number is regarded as IBM370-fo
floating-point data in an unformatted input/output statement. The optional argumentunit
specifies an integer from 0 to 2147483647 as the unit number. If optional argumentunit is
omitted, the C option is valid for all unit numbers connected to unformatted files. When
specified unit number is connected to a formatted file, the option is ignored for the file. W
the C option is not specified, the data of an unformatted file associated with unit numberunit
is regarded as IEEE-format floating-point data in an unformatted input-output statemen

Example:
a.exe /Wl,C10

M
The M option specifies whether to output the diagnostic message (jwe0147i-w) when bi
the mantissa are lost during conversion of IBM370-IEEE-format floating-point data. If the
option is specified, a diagnostic message is output if conversion of IBM370-IEEE-forma
floating-point data results in a bits of the mantissa being lost. When the M option is omit
the diagnostic message (jwe0147i-w) is not output.

Example:
a.exe /Wl,M

Q
The Q option suppresses padding of an input field with blanks when a formatted input s
ment is used to read a Fortran record. This option applies to cases where the field widt
needed in a formatted input statement is longer than the length of the Fortran record an
file was not opened with an OPEN statement. The result is the same as if the PAD= spe
in an OPEN statement is set to NO. If the Q option is omitted, the input record is padded
blanks. The result is the same as when the PAD= specifier in an OPEN statement is se
YES or when the PAD= specifier is omitted.
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Example:

a.exe /Wl,Q

Re
Disables the runtime error handler. Traceback, error summaries, user control of errors
ERRSET and ERRSAV, and execution of user code for error correction are suppressed
standard correction is processed if an error occurs.

Example:

a.exe /Wl,Re

Ri
Disables runtime processing of quad precision exceptions.

Example:

a.exe /Wl,Ri

Rm: filename
The Rm option saves the following output items to the file specified by thefilename
argument:

• Messages issued by PAUSE or STOP statements

• Runtime library diagnostic messages

• Traceback map

• Error summary

Example:

a.exe /Wl,Rm:errors.txt

Ry
Enforces Y2K compliance at runtime by generating an i-level (information) diagnostic wh
ever code is encountered which may cause problems after the year 2000A.D. Must be
in conjunction with li option in order to view diagnostic output.

Example:

a.exe /Wl,Ry,li

T or T[u_no]
Big endian integer data, logical data, and IEEE floating-point data is transferred in an u
matted input/output statement. The optional argumentu_nois a unit number, valued between
0 and 2147483647, connected with an unformatted file. Ifu_nois omitted, T takes effect for
all unit numbers. If both T and Tu_noare specified, then T takes effect for all unit number
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Example:

a.exe /Wl,T10

a
When the a option is specified, an abend is executed forcibly following normal program
mination. This processing is executed immediately before closing external files.

Example:

a.exe /Wl,a

d[num] 1
The d option determines the size of the input/output work area used by a direct access
output statement. The d option improves input/output performance when data is read fro
written to files a record at a time in sequential record-number order. If the d option is sp
fied, the input/output work area size is used for all units used during execution.

To specify the size of the input/output work area for individual units, specify the numbe
Fortran records in the shell variable FUnnBF wherenn is the unit number (see”Shell Vari-
ables for Input/Output”on page 151 for details). When the d option and shell variable a
specified at the same time, the d option takes precedence. The optional argumentnumspec-
ifies the number of Fortran records, in fixed-block format, included in one block. The
optional argumentnummust be an integer from 1 to 32767. To obtain the input/output wo
area size, multiplynumby the value specified in the RECL= specifier of the OPEN stateme
If the files are shared by several processes, the number of Fortran records per block m
1. If the d option is omitted, the size of the input/output work area is 4K bytes.

Example:

a.exe /Wl,d10

e[num]
The e option controls termination based on the total number of execution errors. The op
argumentnum, specifies the error limit as an integer from 0 to 32767. Whennumis greater
than or equal to 1, execution terminates when the total number of errors reaches the lim
enumis omitted ornumis zero, execution is not terminated based on the error limit. Howev
program execution still terminates if the Fortran system error limit is reached.

Example:

a.exe /Wl,e10

gnum
The g option sets the size of the input/output work area used by a sequential access in
output statement. This size is set in units of kilobytes for all unit numbers used during e
cution. The argumentnumspecifies an integer with a value of 1 or more. If the g option is
omitted, the size of the input/output work area defaults to 8 kilobytes.
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The g option improves input/output performance when a large amount of data is read f
or written to files by an unformatted sequential access input/output statement. The argu
numis used as the size of the input/output work area for all units. To avoid using exces
memory, specify the size of the input/output work area for individual units by specifying
size in the shell variable fuxxbf, wherexx is the unit number (see”Shell Variables for Input/
Output” on page 151 for details). When the g option is specified at the same time as the
variable fuxxbf, the g option has precedence.

Example:

a.exe /Wl,g10

i

The i option controls processing of runtime interrupts. When the i option is specified, the
tran library is not used to process interrupts. When the i option is not specified, the For
library is used to process interrupts. These interrupts are exponent overflow, exponent u
flow, division check, and integer overflow. If runtime option -i is specified, no exception
handling is taken. The u option must not be combined with the i option. Note that the i op
does not control quad-precision exceptions (see”Ri” on page 147).

Example:

a.exe /Wl,i

lerrlvl errlvl : { i | w | e | s }

The l option (lowercase L) controls the output of diagnostic messages during execution.
optional argumenterrlvl, specifies the lowest error level, i (informational), w (warning), e
(medium), or s (serious), for which diagnostic messages are to be output. If the l option is
specified, diagnostic messages are output for error levels w, e, and s. However, messa
beyond the print limit are not printed.

i

The li option outputs diagnostic messages for all error levels.

w

The lw option outputs diagnostic messages for error levels w, e, s, and u.

e

The le option outputs diagnostic messages for error levels e, s, and u.

s

The ls option outputs diagnostic messages for error levels s and u.
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Example:

a.exe /Wl,le

mu_no

The m option connects the specified unit numberu_noto the standard error output file where
diagnostic messages are to be written. Argumentu_nois an integer from 0 to 2147483647.
If the m option is omitted, unit number 0, the system default, is connected to the standa
error output file. See”Shell Variables for Input/Output”on page 151 for further details.

Example:

a.exe /Wl,m10

n

The n option controls whether prompt messages are sent to standard input. When the n
is specified, prompt messages are output when data is to be entered from standard inpu
formatted sequential READ statements, including list-directed and namelist statements
the n option is omitted, prompt messages are not generated when data is to be entered
standard input using a formatted sequential READ statement.

Example:

a.exe /Wl,n

pu_no

The p option connects the unit numberu_noto the standard output file, whereu_nois an
integer ranging from 0 to 2147483647. If the p option is omitted, unit number 6, the sys
default, is connected to the standard output file. See”Shell Variables for Input/Output”on
page 151 for further details.

Example:

a.exe /Wl,p10

q

The q option specifies whether to capitalize the E, EN, ES, D, Q, G, L, and Z edit output c
acters produced by formatted output statements. This option also specifies whether to
capitalize the alphabetic characters in the character constants used by the inquiry spec
(excluding the NAME specifier) in the INQUIRE statement. If the q option is specified, t
characters appear in uppercase letters. If the q option is omitted, the characters appear
ercase letters. If compiler option-nfix is in effect, the characters appear in uppercase lette
so the q option is not required.
150 Lahey/Fujitsu Fortran 95 User’s Guide



Shell Variables for Input/Output

5,

ci-
y
stem
not

ated
with

d. The
f the
the

=

Example:
a.exe /Wl,q

ru_no
The r option connects the unit numberu_noto the standard input file during execution, where
u_nois an integer ranging from 0 to 2147483647. If the r option is omitted, unit number
the system default, is connected to the standard input file. See”Shell Variables for Input/
Output” on page 151 for further details.

Example:

a.exe /Wl,r10

u
The u option controls floating point underflow interrupt processing. If the u option is spe
fied, the system performs floating point underflow interrupt processing. The system ma
output diagnostic message jwe0012i-e during execution. If the u option is omitted, the sy
ignores floating point underflow interrupts and continues processing. The i option must
be combined with the u option.

Example:
a.exe /Wl,u

x
The x option determines whether blanks in numeric edited input data are ignored or tre
as zeros. If the x option is specified, blanks are changed to zeros during numeric editing
formatted sequential input statements for which no OPEN statement has been execute
result is the same as when the BLANK= specifier in an OPEN statement is set to zero. I
x option is omitted, blanks in the input field are treated as null and ignored. The result is
same as if the BLANK= specifier in an OPEN statement is set to NULL or if the BLANK
specifier is omitted.

Example:

a.exe /Wl,x

Shell Variables for Input/Output
This section describes shell variables that control file input/output operations

FUnn = filname
The FUnn shell variable connects units and files. The valuenn is a unit number. The value
filenameis a file to be connected to unit numbernn. The standard input and output files
(FU05 and FU06) and error file (FU00) must not be specified.
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The following example shows how to connect myfile.dat to unit number 10 prior to the s
of execution.

Example:
set FU10=myfile.dat

FUnnBF = size
The FUnnBF shell variable specifies the size of the input/output work area used by a seq
tial or direct access input/output statement. The valuenn in the FUnnBF shell variable
specifies the unit number. The size argument used for sequential access input/output s
ments is in kilobytes; thesizeargument used for direct access input/output statements is
records. Thesizeargument must be an integer with a value of 1 or more. Asizeargument
must be specified for every unit number.

If this shell variable and the g option are omitted, the input/output work area size used
sequential access input/output statements defaults to 1 kilobytes. Thesizeargument for direct
access input/output statements is the number of Fortran records per block in fixed-bloc
mat. Thesizeargument must be an integer from 1 to 32767 that indicates the number of
Fortran records per block. If this shell variable and the d option are omitted, the area si
1K bytes.

Example 1:
Sequential Access Input/Output Statements.

When sequential access input/output statements are executed for unit number 10, the
ments use an input/output work area of 64 kilobytes.

set FU10BF=64

Example 2:
Direct Access Input/Output Statements.

When direct access input/output statements are executed for unit number 10, the num
Fortran records included in one block is 50. The input/output work area size is obtained
multiplying 50 by the value specified in the RECL= specifier of the OPEN statement.

set FU10BF=50
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Lahey Computer Systems takes pride in the relationships we have with our customers.
maintain these relationships by providing quality technical support, an electronic mail (
mail) system, a web site, newsletters, product brochures, and new release announcem
The World Wide Web site has product patch files, new Lahey product announcements,
of Lahey-compatible software vendors and information about downloading other Fortra
related software. In addition, we listen carefully to your comments and suggestions.

Hours

Lahey’s business hours are

7:45 A.M. to 5:00 P.M. Pacific Time Monday - Thursday

7:45 A.M. to 1:00 P.M. Pacific Time Friday

Telephone technical support is available

8:30 A.M. to 3:30 P.M. Pacific Time Monday - Thursday

8:30 A.M. to 12:00 P.M. Pacific Time Friday

We have several ways for you to communicate with us:

• TEL: (775) 831-2500 (PRO version only)

• FAX: (775) 831-8123

• E-MAIL: support@lahey.com

• ADDRESS: 865 Tahoe Blvd.

P.O. Box 6091

Incline Village, NV 89450-6091 U.S.A.
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Technical Support Services
Lahey provides free technical support to registered users. This support includes assis
in the use of our software and in getting any bugs you may find in our software fixed. It d
not include tutoring in how to program in FORTRAN or how to use any host operating
system.

How Lahey Fixes Bugs
Lahey’s technical support goal is to make sure you can create working executables us
LF95. Towards this end, Lahey maintains a bug reporting and prioritized resolution syst
We give a bug a priority based on its severity.

The definition of any bug’s severity is determined by whether or not it directly affects yo
ability to build and execute a program. If a bug keeps you from being able to build or exe
your program, it receives the highest priority. If you report a bug that does not keep you f
creating a working program, it receives a lower priority. Also, if Lahey can provide a
“workaround” to the bug, it receives a lower priority.

In recognizing that problems sometimes occur in changing software versions, Lahey al
you to revert to an earlier version of the software until Lahey resolves the problem.

Lahey continues to fix bugs in a numbered version of LF95 until 60 days after the next n
bered version is released.

Contacting Lahey
To expedite support services, we prefer written or electronic communications via FAX
mail. These systems receive higher priority service and minimize the chances for any
takes in our communications.

Before contacting Lahey Technical Support, we suggest you do the following to help us
cess your report.

• Determine if the problem is specific to code you created. Can you reproduce it using
the demo programs we provide?

• If you have another machine available, does the problem occur on it?

Information You Provide
When contacting Lahey, please include or have available the information listed below.

For All Problems
1. The Lahey product name, serial, and version numbers.
2. A description of the problem to help us duplicate it. Include the exact error message

numbers and/or message text.
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For Compiler Problems
1. An example of the code that causes the problem. Please make the example as sma

as possible to shorten our response time and reduce the chances for any
misunderstandings.

2. A copy of theLF95.FIG file (driver configuration file).

3. Command-line syntax and any options used for the driver or other tools.

For Other Problems
1. The brand and model of your system.

2. The type and speed of your CPU.

Lahey will respond promptly after we receive your report with either the solution to the pr
lem or a schedule for solving the problem.

Technical Support Questionnaire
The Lahey Tech Support Questionnaire utility can be used to facilitate the gathering of
ical information for your support request. It may even help you solve your problem on th
spot. It presents a series of dialogs that will guide you to provide the most pertinent info
tion, generating a file that you can attach to your e-mail to support@lahey.com. Start it f
the LF95 toolbar in Lahey ED Developer, or from the Lahey/Fujitsu Fortran 95 folder in yo
Programs menu, or run TSQ.

World Wide Web Site
Our URL ishttp://www.lahey.com . Visit our web site to get the latest information and
product patch and fix files and to access other sites of interest to Fortran programmers

Lahey Warranties

Lahey’s 30 Day Money Back Guarantee
Lahey agrees to unconditionally refund to the purchaser the entire purchase price of the
uct (including shipping charges up to a maximum of $10.00) within 30 days of the origin
purchase date.

All refunds require a Lahey Returned Materials Authorization (RMA) number. Lahey m
receive the returned product within 15 days of assigning you an RMA number. If you p
chased your Lahey product through a software dealer, the return must be negotiated th
that dealer.

Lahey’s Extended Warranty
Lahey agrees to refund to the purchaser the entire purchase price of the product (exclu
shipping) at any time subject to the conditions stated below.
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All refunds require a Lahey Returned Materials Authorization (RMA) number. Lahey m
receive the returned product in good condition within 15 days of assigning you an RMA
number.

You may return a LF95 Language System if:

• It is determined not to be a full implementation of the Fortran 90 Standard and Lahey
does not fix the deviation from the standard within 60 days of your report.

• Lahey fails to fix a bug with the highest priority within 60 days of verifying your
report.

• All returns following the original 30 days of ownership are subject to Lahey’s dis-
cretion. If Lahey has provided you with a source code workaround, a compiler patch,
a new library, or a reassembled compiler within 60 days of verifying your bug report,
the problem is considered by Lahey to be solved and no product return and refund is
considered justified.

Return Procedure
You must report the reason for the refund request to a Lahey Solutions Representative
receive an RMA number. This RMA number must be clearly visible on the outside of th
return shipping carton. Lahey must receive the returned product within 15 days of assig
you an RMA number. You must destroy the following files before returning the product
a refund:

• All copies of Lahey files delivered to you on the software disks and all backup
copies.

• All files created by this Lahey Language System.

A signed statement of compliance to the conditions listed above must be included with
returned software. Copy the following example for this statement of compliance:

I, ________________________________________(your name), in accordance with t
terms specified here, acknowledge that I have destroyed all backup copies of and all o
files created with the Lahey software. I no longer have in my possession any copies o
returned files or documentation. Any violation of this agreement will bring legal action g
erned by the laws of the State of Nevada.
Signature:
Print Name:
Company Name:
Address:

Telephone:
Product: Version: Serial #:
RMA Number:
Refund Check Payable To:
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Return Shipping Instructions
You must package the software diskettes with the manual and write the RMA number on
outside of the shipping carton. Shipping charges incurred will not be reimbursed. Ship

Lahey Computer Systems, Inc.
865 Tahoe Blvd.
P.O. Box 6091

Incline Village, NV 89450-6091
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